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[bookmark: _Toc468348316]About 

This application is a powerful yet easy-to-use reporting tool. It runs in your web browser and does not require any downloads.
[bookmark: __RefHeading__11161_1934010483][bookmark: _Toc468348317][bookmark: chapter_01_getting_started_confi_7936][bookmark: chapter_01_getting_started_confi_662][bookmark: _Toc296683214]Supported Browsers
Supported browsers include:
· Firefox 3+
· Internet Explorer 9+ / Edge
· Google Chrome
· Safari
[bookmark: _Toc468348318]Navigation
This application consists of two sections. On the left is the Main Menu and on the right are Tabs. The Main Menu displays the available reports, folders, and buttons. Tabs can contain the New Report Wizard, report outputs, design windows, or help pages.
[image: ]
[bookmark: _Main_Menu][bookmark: _Toc468348319]
Main Menu
Through the Main Menu you can:

· Create new reports
· Search for reports
· Read report descriptions
· Run reports 
· Export reports to other types (Excel, PDF, RTF and CSV)
· Duplicate reports to save time setting up reports that are similar
· Edit reports
· Delete reports 
· Schedule reports to be emailed or archived
· Manage folders and report storage
Press the splitter [image: ] to hide the Main Menu. This is located in the top left corner of the application's interface between the Main Menu and the Tabs.
[bookmark: _Tabs][bookmark: _Toc468348320]Tabs
The right section is made up of tabs containing the New Report Wizard, reports outputs, design windows, or help pages. Tabs can be closed by pressing the [image: ] to the right of the tab name.
[image: ]

Tabs can be rearranged by clicking and dragging them left or right.
[image: ]
[bookmark: _Types_of_Reports]

[bookmark: __RefHeading__11167_1934010483][bookmark: _Toc468348321][bookmark: _Toc306613054]Creating New Reports

To create a new report, press the New Report Button. This will launch the designer for the selected report type.
[image: ]
[bookmark: _Toc468348322]Types of Reports
This application has six types of reports.
[image: ]
· [image: ] ExpressViews – These are a quick way to view your available data in an easy-to-use format. The intuitive drag-and-drop interface enables you to create beautiful views with minimal effort. For more information, see ExpressView Designer.
· [image: ] Express Reports – This simplified report designer enables you to quickly build reports with basic layouts and calculations. For more information, see Express Reports.
· [image: ] Standard Reports – This type of report uses an intuitive grid to lay out data and labels. Standard reports can provide more complex sections in which to group data and make specialized calculations. For more information, see Report Designer.
· [image: ] Crosstab Reports – Crosstab reports utilize the Standard Report Designer to create reports that may expand both horizontally and vertically based on data. For more information, see Crosstabs.
· [image: ] Dashboards – This is a canvas for combining and laying out reports, data visualizations, images, text and web pages. For more information, see Dashboards.
· [image: ] Chained Reports – This type of report compiles multiple reports into a single document. For more information, see Chained Reports.

[bookmark: _Express_Report_Wizard_1][bookmark: _ExpressView_Designer][bookmark: _Toc468348323]ExpressView Designer
The designer has two parts: The Fields pane and the Design pane. On the left, you can browse data fields and add them to the ExpressView. On the right, you can customize your design.
[image: ]
[bookmark: _Fields][bookmark: _Toc468348324]Selecting a Data Field
The left pane contains all the Data Fields you have access to, sorted by their category. To see all the fields in a category, press the [image: ] (Expand) button to its left:
[image: ]
The icon to the left of each field indicates the type of data it contains:
· [image: ] text
· [image: ] numeric
· [image: ] date/time
· [image: ] other
On top is a search bar. To search for a field by name, enter some text into the bar, then press the [image: ] (Search) button. To clear the search press the [image: ] (Clear) button.
Below the search bar are search filters. To filter for a specific type of data, press the button for that data type. Press it again to clear the filter. Only one data type may be filtered at a time.
[bookmark: _Design][bookmark: _Toc468348325]Viewing your Data
The right pane is where you'll view and organize your data. To add a field to the ExpressView, drag-and-drop it from the Fields pane to the Design pane; Or double-click the field; Or select the field and press the [image: ] (Add Field) button.
A new column representing the data from your field will be automatically added to the design. You can add as many columns as you like.
[bookmark: _Data_Column]Data Columns
[image: ]
Columns are initially populated with placeholder data. This increases the performance and responsiveness of the designer. To see the actual data in the columns, switch the ExpressView to Live Mode by pressing the Live Mode switch:
[image: ]
[image: ]
In Live Mode, you can see your data, but you can no longer edit the ExpressView.
Switch it back to Design Mode to see what customizations you can make.
[image: ]
Parts of a Column
Each data column comprises a header, data, and total.
[bookmark: _Header]Header
[image: ]
On the left side of the header is the header icon / Radial Menu button.
· This icon will be a different color depending on the level of grouping.
· Click to open the Radial Menu...
· 
In the middle is the name of the data field.
· Click-and-drag left or right to change the position of the column.
· In Live Mode, pressing a group header collapses the group.
· 
On the right side is the Sort indicator.
· The arrow indicates the direction of the sort: [image: ]Ascending or [image: ]Descending. Click to change the sort direction.
· The number indicates the sort priority. A lower number means that a column is sorted before the columns with higher numbers.
[bookmark: _Data_2]Data
[image: ]
Placeholder data is numbered to indicate the sort direction.
[bookmark: _Total]Total
[image: ]
At the bottom of each column is an aggregate total row. Click here and select from the dropdown to indicate how to aggregate the column data. You can select either Count, Sum, Minimum Value (Min), Maximum Value (Max), Distinct Count, or Average (Avg) for each group.
[bookmark: _Radial_Menu]Radial Menu
[image: ]
The Radial Menu is a shortcut for editing columns that puts a suite of context-sensitive tools at an easy-to-reach place.
Using the radial menu, you can:
· Group and ungroup columns,
· Change column grouping,
· Sort by a column,
· Change sort ordering,
· Filter by a column,
· and remove columns,
· 
...all with only a single mouse click! Here's how it works.
To get started, choose a column, and click, or click-and-hold on the header button:
[image: ]
A radial menu for that column will open up right at your mouse cursor.
[image: ]
Each of the four "slices" of the menu represents a different action you can perform on your column. Choose an action by moving your mouse over the slice and clicking, or with the menu closed, click and swipe over the desired option.
Options
[image: ]
Group by this column.
Filter by this column. Adds the data field to the Filters menu so you can add conditions.
Sort by this column. Switches the sort precedence to the highest level.
Remove this column from the ExpressView.
Click in the center to dismiss the menu without making a change.
Group Options
The radial menu has some alternative options for a Group column.
[bookmark: _Grouping_your_Data][bookmark: _Grouping][image: ]
Move Group precedence up one. If it is a top-level group, move precedence to the bottom.
Filter by this column. Adds the data field to the Filters menu so you can add conditions.
Sort Order: Swap the sort direction, Ascending or Descending.
Ungroup this column.
[bookmark: _Grouping_Columns_Together][bookmark: _Toc468348326]Grouping Columns Together
In an ExpressView, organizing columns into groups is quick and simple. Select the column you want to group by pressing the header icon, then select the Group slice in the Radial Menu.
[image: ]
The selected column will automatically be transformed into a group.
[image: ]
Each group has its own header and footer, and can be individually collapsed by pressing on its header.
Groups can be stacked multiple levels deep.
[image: ]
To ungroup a column, press the header icon, then select the Ungroup slice in the radial menu.
[image: ]
[bookmark: _Toc468348327]Toolbar
On top of the Designer is the Toolbar, which contains buttons for all the tasks you'll need when using an ExpressView.
[image: ]
[image: ] Options
· [image: ] Report Info: View and set a Name, Folder, and Description for the ExpressView.
· [image: ] Create Copy as Standard Report: Copy the current ExpressView to a new Standard Report.
[image: ] Save the ExpressView. If it is read-only, save a duplicate.	Ctrl-S
[image: ] Expand or Collapse all groups.
[image: ] Refresh all data (Live Mode).	Ctrl-R
[image: ] Search the ExpressView.	Ctrl-F
[bookmark: _Live_Mode][bookmark: live_mode][image: ] Live Mode
This switch acts as a toggle between Live Mode and Design Mode.
In Design Mode you can create and make changes to the ExpressView. Columns are populated by placeholder data. When ExpressViews are created or edited, they open in this mode.
Read-only ExpressViews cannot be opened in Design Mode. Create a duplicate to edit.
In Live Mode, ExpressViews are populated by all their data. You can no longer make changes in this mode. When ExpressViews are run, they open in this mode.
[bookmark: _Sorts][bookmark: sorts][image: ] Sorts	S
This button opens the Sorts menu. This menu shows you all the sorts currently active on the ExpressView, and lets you change their direction and order of precedence.
[image: ]
Click-and-drag the handles up or down to re-order sorts.
[image: ]
Select asc or desc to specify the sort direction.
Press [image: ] Apply or [image: ] OK to save your changes.
[bookmark: _Filters][bookmark: filters][image: ] Filters	F
This button opens the Filters menu. This menu shows you all the filters currently active on the ExpressView. You can add, modify, or remove filters from this menu.
[image: ]
To add a filter to the ExpressView, first open the Filters menu. Then click-and-drag a data field from the Fields pane and drop it into the Filters menu.
[image: ]
A filter condition menu will open for the data field. Select an operator from the first dropdown, and a value from the subsequent dropdown(s).
[image: ]
Click on a filter to expand or collapse the condition menu.
Press [image: ] to remove a filter.
Press [image: ] Apply or [image: ] OK to save your changes.
Sections
The Filters menu has two sections:
Meet all of the following conditions
Meet any of the following conditions
Filters in the all section are combined together. Data must satisfy all of the filters.
For example, you may want to view 'Seafood' orders made in the past year. You would add filters "CategoryName is EqualTo 'Seafood'" and "OrderDate is GreaterThan '2016-01-01'" in this section.
Filters in the any section are evaluated separately. Data must satisfy any one of the filters.
For example, you may want to view only records from 'Davolio' and 'Fuller'. You would add filters "LastName is EqualTo 'Davolio'" and "LastName is EqualTo 'Fuller'" in this section.
Click-and-drag the handles up or down to change a filter's section.
[image: ]
[bookmark: _Toc468348328]Express Report Wizard
The Express Report Wizard is an interactive tool which allows you to quickly create and edit Express Reports.
Navigate between the tabs by clicking on the tab, or by using the [image: ] Previous and Next [image: ] buttons.
To save an Express Report, press the [image: ] (save) button.
[image: ]
The Express Report Wizard has six sub tabs. The Name, Categories and Layout tabs must be completed while the other tabs are optional.
[bookmark: _Toc468348329]Name Tab
[image: ]
In the Name Tab, enter a report name and select which Folder to save the report.
The report name can be up to 255 characters long. Avoid special characters such as ? : / \ * “ < >.
A report's description appears at the bottom of the Main Menu when it is selected. You may also search by a report's description text.
You cannot create a report inside a folder that is read-only ([image: ]).
[bookmark: _Toc468348330]Categories Tab
[image: ]

In the Categories Tab, select the Data Categories that you would like to have access to on the report. It is important to understand two terms: Data Category and Data Field.
Data Category – A Data Category is a data object that has several attributes. E.g. Orders is a category; each order has an ID, a date, a customer, etc.
Data Field – A Data Field is a single attribute within a category. E.g. Orders.OrderID is numeric value that identifies a specific order.
· To add a Data Category, either drag-and-drop it to the selection pane, or select the Category and press [image: ] Add or [image: ], or double-click the Category.
· To search for a Data Category or folder, enter text into the search bar.
· To see the Data Fields in a Data Category, select the Category and press [image: ].
· Check Suppress Duplicates to suppress any repeated records from that Category.
· To remove a Data Category, press [image: ].
[bookmark: _Toc468348331]Sorts Tab
[image: ]

In the Sorts Tab, specify which Data Fields will be used to determine the order of data on the report.
· To sort by a Data Field, either drag-and-drop it to the selection pane, or select the Data Field and press [image: ] Add or [image: ], or double-click the Category.
· To sort by a Formula, press [image: ] Add Formula. To edit an existing formula, press [image: ]. See Sorting by Formula for more information.
· You can order each sort in Ascending (A-Z, 0-9) or Descending (Z-A, 9-0) order.
· Use the up ([image: ]) and down ([image: ]) arrows to indicate the sort priority.
· To remove a sort, press [image: ].

[bookmark: _Toc468348332]Filters Tab
[image: ]

In the Filters Tab, create statements that will be used to filter the data when you run the report.
There is no limit to the number of filters that can be defined. Filters can be numeric (up to eight decimals) or alphanumeric.
· To filter by a Data Field, either drag-and-drop it to the selection pane, or select the Data Field and press [image: ] Add or [image: ], or double-click the Data Field.
· Use the up ([image: ]) and down ([image: ]) arrows to indicate the filter priority.
· To remove a filter, press [image: ].
· Select the operator (Equal To, Less Than, One Of, etc.) from the operator dropdown.
· Set the filter value either by entering it manually or by selecting a value from the filter dropdown. If the Data Field is a date, the calendar and function buttons can be used to select a value.
· Check Prompt for Value to allow the filter to be modified at the time the report is run.
· Select AND With Next Filter to require that the selected filter and the one below it both evaluate to true. Select OR With Next Filter to require that either one be true.
· Check Group With Next Filter to specify the precedence of the filters. Filters can be nested indefinitely by using the following keyboard shortcuts while a filter is selected:
· Ctrl + [ adds an open-parenthesis before the selected filter.
· Ctrl + ] adds a close-parenthesis after the selected filter.
· Ctrl + Shift + [ removes an open-parenthesis from before the selected filter.
· Ctrl + Shift + ] removes a close-parenthesis from after the selected filter.
[bookmark: _Toc468348333]Layout Tab
[image: ]

In the Layout Tab, select which Data Fields will appear on the report. For each Data Field chosen, the report will automatically create a column header and the Data Field. You can add subtotals, grand totals, and page header/footers.
Display Data
· To place a Data Field on the report, either drag-and-drop it to the selection pane, or select the Data Field and press [image: ] Add or [image: ], or double-click the Data Field.
· To add blank columns that can be edited manually, press [image: ] Add Blank. You can enter text into a blank column.
· Use the up ([image: ]) and down ([image: ]) arrows to indicate the order the Data Fields should appear on the report. The Data Field at the top will appear as the leftmost column of the report.
· The Summary Function column is used to make subtotals and grand totals. See Subtotals and Grand Totals for more information.
· To remove a Data Field, press [image: ].
For each Data Field in the Sorts tab, a checkbox will appear in the 'Summarize By' box. Using the 'Summarize By' box you can display subtotals, grand totals, or headers for the values of a Data Field.
Subtotals and Grand Totals
· To display subtotals, check the box of the Category you want to subtotal. Then, for each Data Field you want totaled, select a Summary Function (see below).
· To display grand totals, check the Grand Total box. Then, for each Data Field you want totaled, select a Summary Function (see below).
		Summary Functions:
· Sum: Totals the all of the data in the Data Field.
· Count: Returns the number of rows in the Data Field.
· Average: Takes the mean of the data in the Data Field.
· Minimum: Displays the lowest value in the Data Field.
· Maximum: Displays the highest value in the Data Field.
[image: ]
Data Headers
To display a header for each value of a Data Field, click on the associated Data Category in the 'Summarize By' box. Click the Data Category name next to the checkbox, and the Header Menu will appear.
· To include a blank row before each unique value of the selected Data Field, check Add space before each unique item.
· To include a Header, check Include Header at the beginning. In order to select the text that will appear as the header value, use the Header Text dropdown to select a Data Field or use the Formula Editor Button ([image: ]) to create a formula.
· Use the Summarize by each unique dropdown to specify if the header should repeat based on a specific Data Field or if it should repeat for all of the keys of a Category. 
· Check Include Total at the end to have a subtotal created for this Category.
[image: ]
Page Header
[image: ]
To display information on the top of each page, check Page Header. Press Page Header and the Page Header Menu will appear:
[image: ]
· Check Include Title at the top of every page to display the name of the report on each page. If an image is also included, use the position dropdown to set where the title should appear and the number of columns it should span.
· Use the Change Image button to upload an image to display at the top of each page. If a title is also included, use the Position dropdown to set where the image should appear and the number of columns it should span.
Footers
[image: ]
To display information on the bottom of each page, check Page Footer. Press Page Footer and the Page Footer Menu will appear:
[image: ]
· Check Include page number at the bottom of every page to display the page number on each page. If an image is also included, use the position dropdown to set where the page number should appear and the number of columns it should span.
· Use the Change Image button to upload an image to display at the bottom of each page. If the page number is also included, use the Position dropdown to set where the image should appear and the number of columns it should span.
Preview
[image: ]
At the bottom of the Layout Tab, a preview will display how the report will appear based on the fields that have been added. You can increase/decrease the size of the preview or hide it altogether by dragging the top of the Express Report Designer box.
Styling Express Reports
[image: ]
The toolbar above the preview can be used to style the Express Report. To utilize this toolbar, select the cell(s) in the preview you want to modify, then use one of the following options:
[image: ][image: ] Undo/Redo – can undo or redo the last change made. You can also use Ctrl+Z / Ctrl+Y, respectively.

[image: ] Layout Options – see Layout Options for more information.

 Font – see Font for more information.

[image: ] Foreground & Background Color – see Color for more information.

[image: ] Number/Date Format/Border Color – see Formatting Cells for more information. 

[image: ][image: ][image: ][image: ][image: ][image: ][image: ]  Alignment – see Alignment for more information. 

Theme – Quickly style the report using one of the pre-defined themes.

Layout Options
[image: ]
In Layout Options you can hide the detail information and set row shading.
· Check Suppress Detail Rows to only display Subtotals, Grand Totals, Data Headers & Page Headers/Footers.
· To add row shading press [image: ] New and select a color from the color dropdown or enter a hex value.
· Use [image: ] and [image: ] to change the order of the colors. Press [image: ] to remove a color.
Row Shading is only applied to the detail rows that contain Data Fields.

[bookmark: _Toc468348334]Options Tab
The Options Tab allows you to control various report settings.
General Options
[image: ]
· From the Include Setup Info menu, select Top or Bottom to display the data categories, sorts, and filters at either the beginning or end of the report.
· Select which type of Filter menu to display when executing a report that has prompt-for-value filters.
· Default – Display the default type of filter execution window.
· Standard – Display the standard filter execution window.
· Simple with Operator – Display a simplified filter execution window that only allows the operator and value to be changed.
· Simple without Operator – Display a simplified filter window that only allows the filter value to be changed.
· Check Always Show Filters in Report Viewer to show the filter menu and allow changes to be made each time the report is run.
Export Options
[image: ]
General Options
· Use the Default Export Type dropdown to specify the default format for the report.
· Output types can be disabled by unchecking the respective Allowed Export Types box.
Report Viewer Options
· Uncheck Show Grid to disable grid lines.
· Uncheck Simulate PDF to prevent the report from appearing as though it were on a page.
Excel Options
· Check Suppress Formatting to prevent the report formatting from exporting to Excel.
Page Options
· Specify the size of the report in the Page Size dropdown. Default is Letter.
· Set the orientation for the report in the Orientation menu. Default is Portrait.
· Check Fit to Page Width to scale all columns to fit the width of the page.
Advanced Options
[image: ]
In the Advanced Options an Express Report can be converted to a Standard Report.
	IMPORTANT. This CANNOT be undone.
· Press Convert Express Report to a standard report to convert an Express Report to a Standard Report.
[bookmark: _New_Report_Wizard][bookmark: chapter_02_creating_reports_new__7577][bookmark: chapter_02_creating_reports_new__7648][bookmark: _Toc296683220][bookmark: _Toc306613044][bookmark: _Toc468348335]

New Standard Report Wizard
The New Standard Report Wizard is an interactive tool which will walk through the process of creating a new standard report. All of the selections made in the New Standard Report Wizard can be modified in the Report Designer after the report has been created.
Navigate between the tabs by clicking on the tab, or by using the [image: ] Previous and Next [image: ] buttons.
[image: ]
The New Report Wizard has five sub tabs. The Name and Categories tabs must be completed while the other tabs are optional.
[bookmark: _Toc468348336]Name Tab
[image: ]
In the Name tab, enter a report name and select which Folder to save the report.
The report name can be up to 255 characters long. Avoid special characters such as ? : / \ * “ < >.
A report's description appears at the bottom of the Main Menu when it is selected. You may also search by a report's description text.
You cannot create a report inside a folder that is read-only ([image: ]).
[bookmark: _Toc468348337]Categories Tab
[image: ]
[bookmark: _Sorts_Tab]In the Categories Tab, select the Data Categories that you would like to have access to on the report. It is important to understand two terms: Data Category and Data Field.
Data Category – A Data Category is a data object that has several attributes. E.g. Orders is a category; each order has an ID, a date, a customer, etc.
Data Field – A Data Field is a single attribute within a category. E.g. Orders.OrderID is numeric value that identifies a specific order.
· To add a Data Category, either drag-and-drop it to the selection pane, or select the Category and press [image: ] Add or [image: ], or double-click the Category.
· To search for a Data Category or folder, enter text into the search bar.
· To see the Data Fields in a Data Category, select the Category and press [image: ].
· Check Suppress Duplicates to suppress any repeated records from that Category.
· To remove a Data Category, press [image: ].
[bookmark: _Toc468348338]Sorts Tab
[image: ]
In the Sorts Tab, specify which Data Fields will be used to determine the order of data on the report.
· To sort by a Data Field, either drag-and-drop it to the selection pane, or select the Data Field and press [image: ] Add or [image: ], or double-click the Category.
· To sort by a Formula, press [image: ] Add Formula. To edit an existing formula, press [image: ]. See Sorting by Formula for more information.
· You can order each sort in Ascending (A-Z, 0-9) or Descending (Z-A, 9-0) order.
· Use the up ([image: ]) and down ([image: ]) arrows to indicate the sort priority.
· To remove a sort, press [image: ].

[bookmark: _Toc468348339]Filters Tab
[image: ]
[bookmark: _Group_(Min/Max)_Filters]In the Filters Tab, create statements that will be used to filter the data when you run the report.
There is no limit to the number of filters that can be defined. Filters can be numeric (up to eight decimals) or alphanumeric.
· To filter by a Data Field, either drag-and-drop it to the selection pane, or select the Data Field and press [image: ] Add or [image: ], or double-click the Data Field.
· Use the up ([image: ]) and down ([image: ]) arrows to indicate the filter priority.
· To remove a filter, press [image: ].
· Select the operator (Equal To, Less Than, One Of, etc.) from the operator dropdown.
· Set the filter value either by entering it manually or by selecting a value from the filter dropdown. If the Data Field is a date, the calendar and function buttons can be used to select a value.
· Check Prompt for Value to allow the filter to be modified at the time the report is run.
· Select AND With Next Filter to require that the selected filter and the one below it both evaluate to true. Select OR With Next Filter to require that either one be true.
· Check Group With Next Filter to specify the precedence of the filters. Filters can be nested indefinitely by using the following keyboard shortcuts while a filter is selected:
· Ctrl + [ adds an open-parenthesis before the selected filter.
· Ctrl + ] adds a close-parenthesis after the selected filter.
· Ctrl + Shift + [ removes an open-parenthesis from before the selected filter.
· Ctrl + Shift + ] removes a close-parenthesis from after the selected filter.
[bookmark: _Toc468348340]Layout Tab	
[image: ]
In the Layout Tab, select the Data Fields that will appear on the report. For each Data Field chosen, the report will automatically create a column header and place the Data Field in the detail section. Additionally, subtotals, grand totals, and a page header/footer can be created.
Display Data
· To place a Data Field on the report, either drag-and-drop it to the selection pane, or select the Data Field and press [image: ] Add or [image: ], or double-click the Data Field.
· Use the up ([image: ]) and down ([image: ]) arrows to indicate the order the Data Fields should appear on the report. The Data Field at the top will appear as the leftmost column of the report.
· The Summary Function column is used to make subtotals and grand totals. See Subtotals and Grand Totals for more information.
· To remove a Data Field, press [image: ].
For each Data Field added in the Sorts tab, a checkbox will appear in the 'Summarize By' box. Using the 'Summarize By' box you can display subtotals, grand totals, or headers for the values of a Data Field.
[image: ]
[bookmark: _Sub-Totals_and_Grand]Subtotals and Grand Totals
· To display subtotals, check the box of the category you want subtotals for in the Summarize By box. Then, for each Data Field you want totaled, select a Summary Function.
· To display grand totals, check the Grand Total box. Then for each Data Field you want totaled, select a Summary Function.
	Summary Functions
	· Sum: Totals the all of the data in the Data Field.
· Count: Returns the number of rows in the Data Field.
· Average: Takes the mean of the data in the Data Field.
· Minimum: Displays the lowest value in the Data Field.
· Maximum: Displays the highest value in the Data Field.


Data Headers
Each Data Category in the Sorts tab will appear in the 'Summarize By' box. To display a header for each value of a Data Field, click on the Data Category name and a Header Menu will appear.
· To include a Header, check Include Header at the beginning. In order to select the text that will appear as the header value, use the Header dropdown to select a Data Field or use the Formula Editor Button ([image: ]) to create a formula.
· Use the Summarize by each unique dropdown to specify if the header should repeat based on a specific field or fields within a Category.
· Check Include Total at the end to have a subtotal created for this Category.
Page Header
[image: ]
To display information on the top of each page, check Page Header. Press Page Header and the Page Header Menu will appear.
[image: ]
· Check Include Title at the top of every page to display the name of the report on each page. If an image is also included, use the position dropdown to set where the title should appear and the number of columns it should span.
· Use the Change Image button to upload an image to display at the top of each page. If a title is also included, use the Position dropdown to set where the image should appear and the number of columns it should span.
Footers
[image: ]
To display information on the bottom of each page, check Page Footer. Press Page Footer and the Page Footer Menu will appear.
[image: ]
· Check Include page number at the bottom of every page to display the page number on each page. If an image is also included, use the position dropdown to set where the page number should appear and the number of columns it should span.
· Use the Change Image button to upload an image to display at the bottom of each page. If the page number is also included, use the Position dropdown to set where the image should appear and the number of columns it should span.
Preview
[image: ]
At the bottom of the Layout Tab, a preview will display how the report will appear based on the fields that have been added. You can increase/decrease the size of the preview or hide it altogether by dragging the top of the preview box.
[bookmark: _New_CrossTab_Wizard][bookmark: _Express_Reports_Wizard][bookmark: _Toc468348341]New Crosstab Wizard
The New Crosstab Wizard is an interactive tool which will walk through the process of creating a new Crosstab report. All of the settings in the New Crosstab Wizard can be modified in the Report Designer after the report has been created.
Navigate between the tabs by clicking on the tab, or by using the [image: ] Previous and Next [image: ] buttons.
[image: ]
The New Report Wizard has four sub tabs. The Name, Categories, and Layout tabs must be completed while the other tabs are optional.
[bookmark: _Toc468348342]Name Tab
[image: ]

In the Name tab, enter a report name and select which Folder to save the report.
The report name can be up to 255 characters long. Avoid special characters such as ? : / \ * “ < >.
A report's description appears at the bottom of the Main Menu when it is selected. You may also search by a report's description text.
You cannot create a report inside a folder that is read-only ([image: ]).
[bookmark: _Toc468348343]Categories Tab
[image: ]
In the Categories Tab, select the Data Categories that you would like to have access to on the report. It is important to understand two terms: Data Category and Data Field.
Data Category – A Data Category is a data object that has several attributes. E.g. Orders is a category; each order has an ID, a date, a customer, etc.
Data Field – A Data Field is a single attribute within a category. E.g. Orders.OrderID is numeric value that identifies a specific order.
· To add a Data Category, either drag-and-drop it to the selection pane, or select the Category and press [image: ] Add or [image: ], or double-click the Category.
· To search for a Data Category or folder, enter text into the search bar.
· To see the Data Fields in a Data Category, select the Category and press [image: ].
· Check Suppress Duplicates to suppress any repeated records from that Category.
· To remove a Data Category, press [image: ].
[bookmark: _Toc468348344]Filters Tab
[image: ]
In the Filters Tab, create statements to filter the data at runtime.
There is no limit to the number of filters that can be defined. Filters can be numeric (up to eight decimals) or alphanumeric.
· To filter by a Data Field, either drag-and-drop it to the selection pane, or select the Data Field and press [image: ] Add or [image: ], or double-click the Data Field.
· Use the up ([image: ]) and down ([image: ]) arrows to indicate the filter priority.
· To remove a filter, press [image: ].
· Select the operator (Equal To, Less Than, One Of, etc.) from the operator dropdown.
· Set the filter value either by entering it manually or by selecting a value from the filter dropdown. If the Data Field is a date, the calendar and function buttons can be used to select a value.
· Check Prompt for Value to allow the filter to be modified at the time the report is run.
· Select AND With Next Filter to require that the selected filter and the one below it both evaluate to true. Select OR With Next Filter to require that either one be true.
· Check Group With Next Filter to specify the precedence of the filters. Filters can be nested indefinitely by using the following keyboard shortcuts while a filter is selected:
· Ctrl + [ adds an open-parenthesis before the selected filter.
· Ctrl + ] adds a close-parenthesis after the selected filter.
· Ctrl + Shift + [ removes an open-parenthesis from before the selected filter.
· Ctrl + Shift + ] removes a close-parenthesis from after the selected filter.
[bookmark: _Toc468348345]Layout Tab
[image: ]

In the Layout Tab, design the Crosstab by moving Data Fields into the Row Header, Column Header, and Tabulation Data panels.
Row Headers
Row Headers expand a Crosstab vertically. A Crosstab has a row for each unique value of a Row Header.
E.g. If you were using sales data, you might select Row Headers Category.CategoryName and Products.ProductName to provide rows for each product grouped by category.
· To add a Row Header, either drag-and-drop the Data Field to the Row Header Source panel or select the Data Field and press [image: ].
· Use the Formula Editor Button ([image: ]) to insert a formula into the Row Header.
· Use the Edit Header button ([image: ]) to open the header options menu.

[image: ]
In the Header Options Menu, you can:
· Set a Label for the Row Header. This label will appear at the top of the Crosstab.
· Select a sorting Method and Direction:

· None – Does not sort the Row Headers.
· Header Value (Text) – Sorts the Row Header by its values as though they are text.
· Header Value (Number) – Sorts the Row Header by its values as though they are numbers.
· Tabular Totals – Sorts the Row Header by the totals of the Tabulation Data. 
If there is more than one Row Header, the Header Options Menu for the top-most Row Header will have Options for subtotals of Tabulation Data.
· Select where to display subtotals using the Placement dropdown:

· None – Does not display subtotals.
· Top – Displays subtotals above the Tabulation Data for each Row Header value.
· Bottom – Displays subtotals below the Tabulation Data for each Row Header value.
· Set a Label for the subtotals.
· Use the up ([image: ]) and down ([image: ]) arrows to rearrange the order of the Row Headers.
· To remove a Row Header, press [image: ].
Column Headers
Column Headers expand a Crosstab horizontally. A Crosstab has a column for each unique value of a Column Header.
E.g. If you were using sales data, you may have the Column Headers Year({Order.OrderDate}) and Month({Orders.OrderDate}) to provide columns for each month grouped by year.
· To add a Column Header, either drag-and-drop the Data Field to the Column Header Source panel or select the Data Field and press [image: ].
· Use the Formula Editor Button ([image: ]) to insert a formula into the Column Header.
· Use the Edit Header button ([image: ]) to open the Header Options menu.

[image: ]

In the Header Options Menu, you can:
· Set a Label for the Column Header to appear at the top of the Crosstab.
· Select a Sorting Method and Direction:

· None – Does not sort the Column Headers.
· Header Value (Text) – Sorts the Column Header by its values as though they were text.
· Header Value (Number) – Sorts the Column Header by its values as though they were numbers.
· Tabular Totals – Sorts the Column Header by the totals of the Tabulation Data.
If there is more than one Column Header, the Header Options Menu for the topmost Column Header will have Options for subtotals of Tabulation Data.
· Select where to display subtotals by using the Placement dropdown.

· None – Does not display subtotals.
· Left – Displays subtotals to the left of the Tabulation Data for each Column Header value.
· Right – Displays subtotals to the right of the Tabulation Data for each Column Header value.
· Set a Label for the subtotals.
· Use the up ([image: ]) and down ([image: ]) arrows to rearrange the order of the Column Headers.
· To remove a Column Header, press [image: ].
Tabulation Data
Tabulation Data provides information when data exists for both the Column Header and Row Header values.
E.g. If you have a Row Header on Products and a Column Header on the Month, then Tabulation Data of Orders.OrderID may use the Count function to display how many orders contained each product each month.
· To add a Tabulation Data Source, either drag-and-drop the Data Field to the Tabulation Data panel or select the Data Field and press [image: ].
· Use the Formula Editor Button ([image: ]) to insert a formula into the Tabulation Data.
· Use the Edit Tabulation button ([image: ]) to open the Tabulation Options menu.

[image: ]

In the Tabulation Options Menu, you can:
· Set a Label for the Tabulation Row to appear at the beginning of each row.
· Use the Method dropdown to select the summary function to be applied to the Tabulation Data.

	Summary Functions
	· Sum: Totals the all of the data in the Tabulation Data.
· Count: Returns the number of rows in the Tabulation Data.
· Average: Takes the mean of the data in the Tabulation Data.
· Minimum: Displays the lowest value in the Tabulation Data.
· Maximum: Displays the highest value in the Tabulation Data.
· None: Displays the value in the Tabulation Data without doing any calculations.



· Use the Value dropdown to select how the Tabulation Data should be displayed:
· Aggregate: Display the result of the selected Method.
· Percent of Row: Display the result of the selected Method as a percentage of the row total.
· Percent of Colum: Display the result of the selected Method as a percentage of the column total.
· Use the up ([image: ]) and down ([image: ]) arrows to rearrange the order of the Tabulation Data.
· To remove a Tabulation Data Source, press [image: ].
Crosstab Themes
The Theme dropdown can be used to quickly style the Crosstab using a predefined theme. Further styling can be done in the Report Designer.
Crosstab Options
Settings that affect the entire Crosstab are controlled in the Crosstab Options menu.
[image: ]
Using this menu, you can adjust the following settings:
General 
· Use the Row Headers Placement dropdown to determine how the Row Headers are displayed.
· Columns – Display the Row Headers in columns from left to right in the order they appear in the Row Header Source panel.
· Hierarchical – Display Row Headers in a hierarchical structure using indentation to display their order.
· Check Repeat Crosstab Header every new page to repeat Row Header labels and Column Headers on each new page.
Grand Total Row
· To get a total for each column, select Top or Bottom from the Placement dropdown and provide a label in the Label text box.
Grand Total Column
· To get a total for each row, select Top or Bottom from the Placement dropdown and provide a label in the Label text box.
Preview
[image: ]

At the bottom of the Layout Tab, a preview will display how the Crosstab will appear based on the fields that have been added. You can increase/decrease the size of the preview or hide it altogether by dragging the top of the preview box.
[bookmark: _Express_Reports_Wizard_1][bookmark: _Express_Report_Wizard][bookmark: _Styling_Express_Reports][bookmark: _Layout_Options][bookmark: _Express_Report_Themes.][bookmark: _Dashboard_Wizard][bookmark: _Toc468348346]Searching Reports

To search for a specific report, enter your search terms in the search box in the Main Menu. All reports that contain one or more of the search terms in their names will appear.
[image: ]
To cancel your search and return to a complete list of reports, press [image: ].
To expand your search to include report descriptions, press [image: ] and check Include Description (slower).
[image: ]
[bookmark: _Toc468348347]Folder Management

If you do not see a Manage Folders button in the Main Menu, then you do not have folder management privileges and should contact your administrator.
In the Main Menu, press [image: ]. A dropdown menu will appear:
[image: ]

[image: ] Add root folder: Add a new folder at the base of the directory.
[image: ] Add child folder: Add a new folder within the selected folder.
[image: ] Rename folder: Rename the selected folder.
[image: ] Delete folder: Delete the selected folder. The folder must be empty.
A folder marked read-only ([image: ]) cannot be modified.
[bookmark: _Toc468348348]Editing Reports

To edit an existing report:
On the Main Menu, select the report you want to edit and press [image: ], or double-click the report.
· For ExpressViews, the ExpressView Designer will open to Design Mode in a new tab.
· For Standard and Crosstab reports, the Report Designer will open in a new tab.
· For Express Reports, the Express Report Wizard will open in a new tab.
· For Chained Reports, the Chained Report Wizard will open in a new tab.
· For Dashboards, the Dashboard Designer will open in a new tab.
You cannot edit reports marked read-only ([image: ]). You can duplicate a read-only report into an unlocked folder and edit the duplicate.
[bookmark: _Report_Designer][bookmark: chapter_03_editing_reports_repor_3780][bookmark: chapter_03_editing_reports_repor_915][bookmark: _Toc296683228][bookmark: _Toc306613052][bookmark: _Toc468348349]Report Designer
The Report Designer can be used to add data, charts, formulas, sorts, filters and many other features to a report.
The Report Designer has three parts: the Design Grid, the Data Menu and the Toolbar.
[image: ]
[bookmark: _Design_Grid][bookmark: _Toc468348350]Design Grid
In the design grid, you can:
· Add and delete rows, columns, and sections.
· Enter data fields, text, and formulas.
· Drag-and-drop fields into different sections, rows, or columns.
[bookmark: _Sections][bookmark: _Toc468348351]Sections
[image: ]
Sections dictate how the data appears in a report. There are five types of sections: page, report, details, group, and repeating group.
[image: ]Page Header & [image: ]Page Footer – The rows in the Page Header section appear at the top of every page of a report. Typically, the Page Header section is used to designate column headers for a report. The rows in the Page Footer section appear at the bottom of every page of a report. Typically, the Page Footer sections are used to display the page number and/or confidentiality notices for a report.
Page Headers and Page Footers are not intended to perform calculations or display data fields. For this reason, a Page Header populated with a data field will only return the first line of data in that field; a Page Footer will return only the last line of data.

If you are printing a report, remember that Excel output does not have pages. Page Headers will appear only once at the beginning of the report. Reports run via the Report Viewer will display Page Headers similarly unless Simulate PDF is checked in the Options menu.
[image: ]Report Header & [image: ]Report Footer – The rows in the Report Header appear at the beginning of a report. Typically, these rows display the title of a report. The rows in the Report Footer appear at the end of a report. Typically, the Report Footer displays grand totals and summary information for the report.
[image: ]Detail – The Detail section is the main section of most reports. When a report is executed, the Details Section creates a row for each element in the Data Categories. For example, if the Detail section contains the Data Field Orders.OrderId, the report will display each Order Id on a separate row.
[image: ]Group Header & [image: ]Group Footer – Group Header/Footer sections require a sort on a Data Field or formula. The rows in a Group Header section will appear above the Detail section for each unique value of the sorted item. Typically, Group Header sections are used to display data as labels. For example, a report may contain a Group Header on Orders.OrderDate and display Orders.OrderId in the Detail section. The output would display each date with orders that occurred on that date below them.
The rows in a Group Footer section will appear below the Detail section for each unique value of the sorted item. Typically, Group Footer sections are used to calculate subtotals. For example, a report may contain a Group Footer on Orders.OrderDate which displays the number of orders made on each date.
[image: ]Repeating Groups – Repeating Groups require a sort on a Data Field or formula. Repeating Groups have their own header, details and footer subsections. Repeating Groups should only be used when the data has multiple one-to-many relationships and each should be rendered completely before the other.
(E.g. Each Professor can teach multiple classes and advise multiple students. For each professor you want to see all the classes they teach and then all the students they advise.)
[bookmark: _Toc306613055]Using Sections
Sections can be added, deleted, modified, moved, and assigned shading.
Adding Sections
 
1. Click anywhere in the Section Column.
2. Hover your mouse over 'Add Section', then select the type of section to add.

Deleting Sections

1. In the Section Column, click on the section to delete.
2. Press 'Delete Section'.

Modify Sections (Group Header/Footers and Repeating Groups)

1. In the Section Column, click on the section to modify.
2. Press 'Modify Section'. This will bring up a 'Modify Group Section' Menu.
3. Select the desired Data Field from the dropdown menu.
4. Press [image: ] OK.

Section Shading

1. In the Section Column, click on the section to Shade.
2. Press 'Section Shading'. This will bring up the Section Shading menu.

[image: ]

3. Press [image: ] New to add a color to the shading.
4. Click the color box and select a color in the dropdown; Or enter a hex value.
5. Press [image: ] OK.
[bookmark: _Toc468348352][bookmark: chapter_04_running_reports_repor_7102][bookmark: chapter_04_running_reports_repor_3222][bookmark: _Toc296683262][bookmark: _Toc306613086]Columns and Rows
Columns and rows of cells can be added, modified, or removed.
Columns
· To select a group of columns, hold the SHIFT key and then click the beginning and ending column.
· Non-contiguous columns can be selected by holding the CTRL key and clicking the desired columns.
· A column can be resized by dragging its right edge horizontally.
· Clicking on a column (or selected group) will display a menu where you can:
[image: ]

· Insert a new column.
· Delete the selected column.
· Set all selected column widths to be identical.
· Hide the selected column.
· Set Column Info to label the column and/or make it sortable in the Report Viewer.
[bookmark: _Sorting_by_Columns]Sorting by Columns in the Report Viewer
While viewing reports in the Report Viewer, a user can click the bar at the top of the report to sort by a column. For Express Reports this is handled automatically, but it must be enabled for Standard and Crosstab Reports.

To make a column sortable:
· Click on the column and select 'Column Info…'
[image: ]
· Provide the column with a Label that will appear in the Interactive Report Viewer Dock.
· From the Sort dropdown select the Data Field to be used for sorting, or provide a formula by pressing the formula button ([image: ]).
Column Sorts are applied AFTER any sorts defined in the Sorts Menu.
· Click on the column again to set a default sort direction.
[image: ]
Rows
· To select a group of rows, hold the SHIFT key, then click the top and bottom rows of the area you wish to select.
· Non-contiguous rows can be selected by holding the CTRL key and clicking the desired rows.
· A row can be resized by dragging its bottom edge vertically.
· Clicking on a row (or selected group) will display a menu where you can:

[image: ]

· Insert a new row.
· Delete the selected row.
· Set the selected row's height to be automatically controlled.
· Suppress the selected row from appearing on the report.
· Insert a page break (See Using Page Breaks)
[bookmark: _Toc468348353]Cells
Cells are the containers for all the information in a report. Cells may contain text, images, charts, or links to other reports.

· To enter text, double-click the cell, and a text field will appear.
· To select cells, either click the cells or use the arrow keys to toggle from one to the next.
· Groups of cells can be selected by holding the SHIFT key and clicking on another cell. All the cells in between the two will be selected.
· Non-contiguous cells can be selected by holding the CTRL key and clicking the desired cells.
· A cell can be copied by holding the CTRL key, then dragging and dropping it into a new cell.
· Adjacent cells can be merged and unmerged using the Merge/Split Cell buttons in the Toolbar:

[image: ]

[bookmark: _Using_Page_Breaks][bookmark: _Toc468348354]Using Page Breaks
For a Page Break to occur at the beginning of each element of a Data Field, place a page break on the top row of the Group Header Section for that Data Field. See Sections for more detail on Group Header Sections.
[image: ]
[bookmark: _Toc468348355]Collapsible Rows
Group Sections can be set to display collapsed by default in the Report Viewer. This causes the contents of the section to be suppressed and individually expandable for each change in the Header. Collapsible rows are only supported in the Report Viewer. Export formats will ignore Collapsible Rows.
Left-click on an arrow next to a Collapsible Row to expand or collapse the group:
[image: ]
Right-click on an arrow next to a Collapsible Row to see additional display options:
[image: ]
Expand will expand the selected top-level group. (This is the same as left-clicking an arrow.)
Collapse will collapse the selected top-level group. The state of the sub-groups is preserved.
Expand Group will expand the selected top-level group and all sub-groups within that group.
Collapse Group will collapse the selected top-level group and all sub-groups within that group.
Expand All will expand every group and sub-group on the page.
Collapse All will collapse every group and sub-group on the page.

Creating a Collapsible Row
To create a Collapsible Row, first open the desired report in the Report Designer. Click on the desired row number in a Group Header Section, and select Collapse Rows in the dropdown menu:
[image: ]

A Collapsible Row is indicated by an arrow at the bottom right of the row number cell.
Properties of a Collapsible Row
Collapsible Rows have the following properties when a report is viewed:
· Collapsible Rows display as collapsed whenever a report is run or altered using the Interactive Report Viewer.
Collapsed or expanded state cannot be saved to User Report preferences.
· Page Breaks below a Collapsible Row are ignored.
· Expanding a Collapsible Row will not alter the Report pagination.

See Sections for more detail on Group Headers Sections.
See Interacting with the Report Viewer for more information the Interactive Report Viewer.
[bookmark: _Data_Menu][bookmark: _Toc468348356]Data Menu
The data menu holds the data that you can put into a report.
[bookmark: _Toc468348357]Adding Data Fields to a Report
To add a Data Field to a report, select the appropriate Data Category at the top of the menu. Drag-and-drop the Data Field from the menu to a cell in the Design Grid.
[image: ][image: ]
Alternatively, a Data Field can be put into a cell by typing Data Category Name (dot) Data Field Name. (E.g. Orders.OrderID).
To access other Data Categories, see  Data Categories.
[bookmark: _Toolbar][bookmark: _Toc468348358]Toolbar
The toolbar contains the buttons and menus used to modify the report. Modifications can include aesthetic formatting, inserting formulas and images, linking reports, and much more.
The toolbar begins with a dropdown menu. This menu controls changes, such as renaming or filtering, that affect the entire report.
[image: ]
[bookmark: _Toc468348359]Saving Reports
The report can be saved by pressing the save button ([image: ]). The report will also save automatically any time it is run or exported.
[bookmark: _Toc468348360]Undo/Redo
Actions can be undone by pressing the undo button ([image: ]) or using the keyboard shortcut Ctrl+Z. Undone actions can be redone by pressing the redo button ([image: ]) or using the keyboard shortcut Ctrl+Y.
[bookmark: _Toc468348361]Font & Alignment Options
The text of each cell can be formatted using dropdown menus and buttons in the toolbar. A cell or multiple cells must be selected for these tools to be used.
[bookmark: _Font]Font	
· Select a font using the font dropdown. Font names appear in the style that they represent.
· B, I, and U, make the font bold, italicized, and underlined, respectively.
· Use the [image: ] menu to set the font size.
[bookmark: _Color]Color
· To change the text color, press [image: ] and select a color or enter a hex value into the box. Press [image: ] to revert to the default color.
· To change the background color, press [image: ] and select a color or enter a hex value into the box. Press [image: ] to revert to the default color.
[bookmark: _Alignment]Alignment
· Text can be aligned to the top, center, or bottom of a cell using the vertical alignment buttons.
[image: ]
Text can be centered, justified, or aligned to the left or right of a cell using the horizontal alignment buttons.
[image: ]
· The wrap text button ([image: ]) will begin a new line if the text is longer than the width of the cell.
[bookmark: _Toc468348362]Formatting Cells
Press [image: ] to open the Format Cells window. The window has three tabs: Number, Border, and Conditional.
Cell formatting can be copied using the Format Paintbrush. Select the format you want to copy, press the format paintbrush button ([image: ]), then click the cell you want to apply the formatting to.
[bookmark: _Number]Number
The Number Tab allows you to set the format of numbers and dates.
· General:
· General format automatically applies formatting to cell values.
· Number:
· Using the arrows, you can specify how many decimals to display. You can also set the symbol to separate decimals from whole numbers.
· Check Use 1000 Separator to separate every 3 digits. You can set which symbol is used to separate digits.
· Check Use Currency Symbols to have the currency sign appear in front of the number.
· Check Append Percent Sign to have a % appear after the number.
· Check Blank When Zero to leave the cell(s) blank if the value is zero.
· Check Show Negative Symbol to have a negative sign display in front of negative numbers.
· Check Show Parenthesis to put ( ) around negative numbers.
· Use the Color picker to make negative numbers a specific color.

[image: ]
· Date:
· Select a time/date format. (E.g. MM-yy will display a date as 'Jun-97').
[image: ]
· [bookmark: _Border]Text format: Formatting  does not apply to cell values.
Border
The Border tab allows you to alter the width and color of the cell edges.

[image: ]
· Uncheck Make Borders Uniform to modify specific edges.
· To widen the borders, enter a value (in px), or use the arrows in the width box.
· To change the color, click the color picker and select a color, or enter a Hex value.
[bookmark: _Conditional_Formatting/Suppression]Conditional Formatting/Suppression

[image: ]
The Conditional tab allows you to set or modify the format of a cell based on a formula you create.

· Press the [image: ] Add button to create a new conditional format. Each format must have an Action and a Formula that evaluates to True or False. Some Actions require an Attribute such as a color or a number.
· Select an Action from the dropdown. This action will occur if the formula evaluates to True. Actions include:
· Foreground Color – Sets the foreground color of the cell.
Attribute: Color
· Background Color – Sets the background color of the cell.
Attribute: Color
· Font Size – Sets the size of the text.
Attribute: Number
· Bold – Bolds the text of the cell.
No Attribute
· Italic – Italicizes the text of the cell.
No Attribute
· Underline – Underlines the text of the cell.
No Attribute
· Horizontal Alignment – Aligns the text of the cell horizontally.
Attributes: Left, Center, Right, or Justify
· Vertical Alignment – Aligns the text of the cell vertically.
Attributes: Top, Bottom, or Middle
· Suppress Row – Suppresses the row the cell is in.
No Attribute
· Suppress Section – Suppresses the entire section that contains the cell.
No Attribute
· Page Break – Starts a new page.
No Attribute
· Press the Formula Editor Button ([image: ]) to set the condition for the formula.
The formula must evaluate to True or False. For conditional formatting, the Formula Editor will have a [image: ] Cell Value button. This button adds the function CellValue() to the formula. This function returns the value of the cell that conditional format is being applied to.

The formula is still calculated with respect to the section of the cell. For example, for a cell in a report footer, the formula '{Order.Profit} > 1000' will return True if the last Order of the detail section profited more than 1,000. To make the condition see if the total profit was greater than 1,000 use the formula 'Sum({Order.Profit})>1000'.
· Use the up ([image: ]) and down ([image: ]) arrows to change the priority of the formats. If two formats share a common action and are both True, then the lower condition will be applied.
· To remove a format, press [image: ].
[bookmark: _Toc468348363]AutoSum
To quickly get a total on a Data Field, place the field in a Report or Group Footer and press the AutoSum button ([image: ]). Alternatively, a sum can be created with the aggSum formula. See Formulas for more information.
Do not use AutoSum on a cell with an aggregate formula such as aggSum.
[image: ]
[bookmark: _Toc468348364]Images
Insert an image from your computer to a cell using the Insert Image button ([image: ]). This opens the Insert Image window. Select the image you would like to insert, and press [image: ] OK.
[bookmark: _Toc468348365]Formulas
Complex calculations can be done using Formulas. A formula can be added to a cell manually or by using the Formula Editor. To open the Formula Editor, press [image: ].
[bookmark: _Toc468348366]Suppress Duplicates
[bookmark: _Toc446410330][bookmark: _Toc446425724]To suppress duplicate values of a Data Object from being displayed select the cell and press [image: ].

[bookmark: _Toc462824871][bookmark: _Toc468348367]Charts
Charts are a way of illustrating data in order to make it easy to spot trends and patterns. Most types of charts are simply a collection of points on a grid, with interstitial designs and labels that make them easier to read.
By default, charts are generated dynamically, based on data points that come from Data Fields. Each data field can be thought of as a "series" of data, which have a common association and are connected in some way. When we put one data field on a chart, we have a single-series chart, which is useful for comparing values to each other. When we put multiple data fields on a chart, we have a multi-series chart, which is useful for comparing trends.
Before creating a chart, make sure that your data exists in cells on the report. These cells don't have to be visible, so you can suppress them if desired. Charts are interactive in the Report Viewer, but will appear as static images in PDF, RTF, and Excel formats (CSV is incompatible).
To insert a chart into a report, select a Group Footer or Report Footer cell and press the [image: ] Chart Wizard button. The Chart Wizard dialog will open.
The Chart Wizard has four tabs: Type, Data, Appearance, Size and Preview. You can navigate between the tabs by clicking on the tab, or using the [image: ] Previous and [image: ] Next buttons.
[bookmark: _Type][bookmark: _Type_1]Type
The Type Tab lays out all the available types of charts you can create. There are 20 types, sorted into five general categories. Click on a category header to see more information about that type.
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[bookmark: _Line,_Spline,_and][bookmark: _Line]Line
Line charts display series of data points on a grid, connected by straight lines. They are often used to display a trend over time.
Each series on a line chart is represented as a colored line. Line charts can have up to three Y-axes.
Variations:
· Spline chart - Data points are connected by interpolated curves instead of straight lines.
· Area chart - The area under each line is filled in by a color. Overlapping areas have mixed colors.
· Spline-Area chart - A combination of a spline chart and an area chart.
· Spark Line chart - Has no grid or axes. Use point labels and benchmark lines for reference.
[bookmark: _Bar_and_Column]Bar and Column
Bar charts use rectangular bars which extend horizontally left to right to show comparisons between categories. Column charts use vertical bars which extend upward. The length of a bar represents the quantity of the data value.
Each series on a bar or column chart is represented by a colored set of bars.
Variations: 
· Stacked bar/column chart - Series are stacked on top of each other, additively.
· 100% Stacked bar/column chart - Series are converted to a % of the max, then stacked on top of each other, additively to 100%.
· Spark column chart - Has no grid or axes. Use point labels and benchmark lines for reference.
· Pareto chart - Combines a descending column chart, where each column is the next highest data value, and an overlapping line chart, where each point is the cumulative sum to that point. Often used to highlight the most important field in a series. Single-series only.
[bookmark: _Pie_and_Other]Pie and Other Single-Series
Pie charts are used to show the relationship of data values in a series as portions of the total. The area of each slice is proportional to the quantity.
Each data value on a pie chart is represented by a colored "slice". Pie charts are single-series only.
Variations:
· Doughnut chart - Pie charts with a hole in the center.
· Pyramid chart - Used to show data hierarchy in addition to value. Data values are represented by vertically stacked slices, the height (not width) proportional to the quantity. The vertical order of the slices is determined by the sort order.
· Funnel chart - Inverted pyramid chart. Often used to show retention amount, or stages in a process. Shape is inverted, not data order. To change the order, swap the sort direction.
[bookmark: _Scatter_and_Bubble]Scatter and Bubble
Scatter charts use pairs of data fields with a common relation to generate coordinates as points on a grid. They are often used to find relationships between two variables in a set of data. Unlike most other report types, scatter charts often map data from detail rows, instead of group rows.
Each series on a scatter chart is represented by a different shape and color combination.
Variations:
· Bubble chart - The points become circular "bubbles", with a third coordinate field as the radius of the bubble.
[bookmark: _Combination_Charts]Combination Charts
Combination charts are several different charts layered on top of one another. They comprise a combination of Column, Line, Area, and/or Stacked Column charts. (Column and Stacked Column charts are not compatible with each other). Combination charts can have up to two Y-axes.
[bookmark: _Pie,_Doughnut,_Pyramid][bookmark: _Scatter][bookmark: _Data_Format]Data
The Data Tab is used to specify which cells to use as chart data. You can change how data is translated into points by changing the data layout. You can also choose a sort order, as well as upper and lower boundaries for the data and axes.
[image: ]
Add series to the chart by selecting a Data Field containing numeric values from the Series Values dropdown menu. Some charts may require you to select a data field to label the X-Axis. Some charts may ask for two or three data fields per series. The data axis is drawn automatically.
Data is on the Y-Axis; this may not always be the vertical axis. Labels are on the X-Axis; this may not always be the horizontal axis. Scatter charts have no labels axis, but have X- and Y- data axes.
Add additional series by pressing the [image: ] Add Series button (disabled for single-series charts). Give a Name to each series. Press [image: ] to remove a series.
Change the data layout by pressing the [image: ] Data Layout... button. This will open the Data Layout dialog. If you change the data layout, this section will change for you to add either individual points, or groups of series, instead of adding individual series. See Data Layout for details.
[image: ]
Use the Sort data by dropdown to determine how series data should be ordered:
Report Order – Use the sort order specified by the report.
Data Labels – Sort by the label axis value, alphabetically or numerically.
Data Values – Sort by the value of the data.
You can sort data in Ascending (A- Z, 0-9) or Descending (Z-A, 9-0) order.
Use the Exclude values fields to ignore values that are too large and/or too small.
(Grid charts) Use the Data Axis Value fields to set upper and/or lower bounds for the data axis.
(Grid charts) Check Align Data Labels Across Series if you have multiple series with data points at common intervals.
(Pie charts) Use the Other Category Percent field to group data fields with small quantities into an "Other" category.
Data Layout
Your data may not fit neatly into series. This dialog accommodates different data layouts by allowing you to select from a couple of different ways to build a chart.
Column Based Chart is the default. This layout builds charts by taking data fields, and mapping selected values as Y-coordinates on the data axis. Determine which values are selected by specifying a data field with a common relation as the X-axis. This layout is useful if you want to plot one or more unrelated series in a group (e.g. Budget and Sales and Expenditures per Store).
Use Column Based Chart if... Your report contains a group with one or more elements. For example:
[image: ]
Row Based Chart is a little more complex. This layout still uses fields as series, but all your series are a group, nested within another group which determines the X-axis values. Data values are mapped per series per group. This layout is useful if you want to plot two or more related series in a group (e.g. Sales per Employee per Store).
Use Row Based Chart if...  Your report contains a group within a group. For example:
[image: ]
If you select this layout, the data selector will change to allow you to add all your series as a group, nested within an outer group for the data labels:
[image: ]
Cell Based Chart is the simplest option. This layout builds charts by taking pairs of static report values, and using them as (X,Y) or (label, value) coordinate pairs.
In order for the chart wizard to recognize report cells, they must be in Formula form, with a preceding = sign, text surrounded by quotes, and data fields surrounded by braces { }. Examples:
Number: =42
Text: ="February 24th"
Data field: ={Employees.EmployeeName}
Formula: =Month{Orders.OrderDate}
Math: ={Orders.UnitPrice} * 2.43
Use Cell Based Chart if... You want to build a chart point by point, and only have one data series. For example:
[image: ]
If you select this layout, the data selector will change to allow you to add points. This layout only supports one series of data (duplicating data labels will create duplicate axis labels):
[image: ]
[bookmark: _Data_Layout_1][bookmark: _Layout_One]Appearance
The Appearance Tab contains options for customizing how the chart will look.
Colors
[image: ][image: ]
Use the Colors dropdown to select a color theme to apply to the chart. Specify a custom range of colors by selecting the Linear Range option.
Check Use 3D Style to give your chart a three-dimensional look.
Labels
[image: ]
Chart Title – Enter the text you want to appear in at the top of the chart.
(Grid charts) X-Axis Title – Enter the text you want to appear on the X-Axis (horizontal axis).
(Grid charts) Y-Axis Title – Enter the text you want to appear on the Y-Axis (vertical axis).
Use the Point Labels dropdown to label the points on the chart:
Series Values
Percent of Series Values
Data Labels
Data Labels with Data Values
Use the Legend Position dropdown to choose where to display the legend relative to the chart.
Use the Label Font dropdown to specify the font for the labels.
Use the [image: ] Number Format... dialog to specify how data and axis labels should be formatted:
[image: ]
(Line & combo charts) Use the [image: ] Chart Axes button to add and format axes:
[image: ]
Press [image: ] Add Y Axis to add an additional axis. Give it a title, and use the formatting options to format the axis labels and data labels for associated series. Press [image: ] to remove an axis.
Y-Axis Assignment – Use the dropdown menu for each series to associate the series with an axis. Each series will have the same format as the axis, and hiding an axis will hide associated series.
Press [image: ] OK when done.
Use the [image: ] Benchmark Lines... dialog to add horizontal lines at specific sections of the chart:
[image: ]
Press [image: ] New to add a benchmark line:
Label – Enter the text you want to label the line.
Value – Set the value for where the line will display.
Color –Specify the color of the line.
Line Style – Solid or Dashed.
Press [image: ] to remove a benchmark line. Press [image: ] OK when done.
Other Features
[image: ]
This section allows you to customize a variety of attributes. The following attributes are supported:
	Font color

	Font size

	Background opacity

	Background color

	Title alignment

	Title font size

	Title on top

	Legend title

	Title font size

	Show border

	Show tooltip

	Subtitle

	Subtitle font size


To add a customization, select an attribute from the dropdown menu and press [image: ] Add Attribute. Then enter a custom property into the attribute field or select from the attribute dropdown menu.
Press [image: ] to remove a customization.
Advanced Features
[image: ]
This section allows an experienced user to add FusionCharts customizations.
Recommended for advanced users only. Not all attributes may be supported.
See Fusion Chart Attributes for available customizations. Attributes differ depending on the type of chart. To see available attributes, select a chart type, then scroll down and expand a category. Property values generally need to be of a certain type and within a certain range.
To add a customization, enter the attribute name, then press [image: ] Add Attribute. Then enter a custom property into the attribute field.
Press [image: ] to remove a customization.
Size and Preview
The Size and Preview Tab allows you to change the size of the chart and preview any customizations.
Chart previews in the Wizard and on the Design Grid use placeholder data.
[image: ]
You can change the size of the chart in one of three ways:
· Drag-and-drop the handle [image: ] at the bottom-right corner.
· Check Fit to Cell and resize the chart cell on the Design Grid.
· Check Set specific size and enter a custom Height and Width (in px).



[bookmark: _Toc468348368]GeoCharts
GeoCharts can be displayed in a report to give a visual representation of geographic data. To insert a GeoChart, select a cell and press the [image: ] (GeoChart Wizard) button. The GeoChart Wizard has three tabs: Type, Locations, and Data.
GeoCharts should only be placed into a Group Header, Group Footer, Report Header or Report Footer section.
[bookmark: _Type_2]Type
[image: ]
In the Type tab select the initial view, size, colors, and where to display the legend.
· Use the Initial View dropdown to select the location that initially displays on the Map. You may either select the world, a continent, or a country.
· There are three ways to set the size of the Map.
· Enter the Height and Width in the dimension boxes.
· Resize the chart by dragging the lower right corner in the preview.
· Check Fit to Cell.
· In the Colors dropdown, either select a color theme or specify a linear range of colors.
· Check Show Legend to display the legend.
[bookmark: _Locations_1]Locations	
[image: ]

In the Locations Tab, specify which geographic locations should display on the Map.

· Use the Location Values dropdowns to select the cells that contain the geographic information for the Map. To utilize Region information, such as states/provinces, Country information must be provided. Similarly, City information requires Region and Country information.
· The Show last Location type as dropdown specifies how to display the lowest level of information. You can either select circular markers or shaded geographic regions.
[bookmark: _Data_1]Data
[image: ]
In the Data Tab, specify which data determines the color of each country/region/city and the size of each marker.
For each Data Value:
· Use the Data Values dropdown to specify which cells on the report should be used to determine the color and the size of each marker. Setting a cell for the size of marker is optional.
· Enter a label in the Data Labels column. Labels will appear in the hover effects of Dynamic Maps.
· Use the Aggregation dropdown to select a method to perform on the data:

	Summary Functions
	· Sum: Totals the all of the data in the Data Field.
· Count: Returns the number of rows in the Data Field.
· Average: Takes the mean of the data in the Data Field.
· Minimum: Displays the lowest value in the Data Field.
· Maximum: Displays the highest value in the Data Field.



· Use the Display Format dropdown to specify how to display the data:

· Default: Displays the values without any formatting.
· Currency: Prepends the currency symbol on the values.
· Percent: Multiplies the Data Value by 100 and appends a percent symbol (%) to the values.
· Scientific Notation: Displays the values in scientific notation.
· E.g. If Decimal Places are set to 2 then 123.45 would appear as 1.23 E2.

· Decimal Places: The number of decimal places to display.
Example
The subsequent steps show how to create a Map using the following data: 
[image: ]
The Map will be colored based on the number of customers in each location and the markers will be sized based on how many orders have been placed in each location.

· Add a Report Footer section to the report, select all the cells in the Report Footer and press the merge cell button ([image: ]).
· Select the merged cell and press the Insert Map icon ([image: ]).
· In the Type tab:
· Set the initial view, size and color.

[image: ]

· In the Locations tab, set the field Customers.Country for Country information, Customers.State for Region, and Customers.City for City information. Set the 'Show last location type as' dropdown to Markers.

[image: ]

· In the Data tab:
· Set the field Customers.CompanyName for Color of Locations. Provide a label such as 'Num. of Customers' and set the Aggregate Type to Distinct Count.
· Set the field Orders.OrderId for the Size of Markers. Provide a label such as 'Num. of Orders' and set the Aggregate Type to Count.

[image: ]
· Press Finish and run the report.


[bookmark: _Toc468348369]Google Maps
The Google Maps wizard allows you to insert interactive maps with highlighted data into your reports. To add a map, select a cell and press the [image: ] (Google Maps Wizard) button. Geographical areas can be pinpointed or highlighted dynamically depending on your report data.
If you don't see this option, you may not have access. Please contact your administrator. Google Maps require an Internet connection.
The Google Maps Wizard has four tabs: Locations, Data, Appearance, and Size and Preview. You can navigate between the tabs by clicking on the tab, or using the [image: ] Previous and Next [image: ] buttons.
[bookmark: _Location][bookmark: _Locations]Locations
[image: ]
In the Locations tab, select one or more types of locations to highlight on the map. Drag-and-drop a location type to the selection pane, or double-click it, or select it and press [image: ].
Certain location types may require other types to be added, or may prevent other types from being added. Press [image: ] to remove a Location Type. For each Location Type, use the dropdown menu to select the report cell that contains the data for that type.
County and zip code are only available in the United States.
[bookmark: _Data]Data
[image: ]
In the Data tab, determine what metrics to see when hovering over a highlighted region. The Primary Metric amount is used to shade each region. Press [image: ] Add Metric to add additional metrics. Press [image: ] to remove a metric.
For each Metric:
Use the Metric dropdown menu to select the report cell that contains the data for that metric.
Select how to aggregate the data using the Agg. Type dropdown:
	Summary Functions
	Sum: Totals the all of the data in the Data Field.
Count: Returns the number of rows in the Data Field.
Distinct Count: Returns the number of unique rows.
Average: Takes the mean of the data in the Data Field.
Minimum: Displays the lowest value in the Data Field.
Maximum: Displays the highest value in the Data Field.



Enter a label in the Labels field.
Select whether it is the Primary Metric.
Format the data type using the Number Format dialog.
[bookmark: _Appearance]Appearance
[image: ]
In the Appearance tab, determine the appearance of the metrics on the map.
Primary Metric Colors: Set the color range for region shading by either selecting a Theme, or by setting a Linear Range of colors.
Metric Levels: Select which levels to calculate metrics. Select whether to display drop pins which will appear on city, street address, or latitude/longitude locations.
[bookmark: _Size_and_Preview]Size and Preview
[image: ]
In the Size and Preview tab, determine the size, initial view, and type of map to display.
The preview uses placeholder data values. It does not reflect the actual region shading.
Set the initial view of the map by panning and zooming to a location. Drag-and-drop on the map to pan. Press the zoom buttons ([image: ][image: ]) to zoom in or out.
To set the size, either drag-and-drop on the lower-right handle of the map view, or check Set specific size and enter Height and Width values. To automatically fit the map to the report cell, check Fit map to cell.
Choose the type of map by selecting the desired type from the Base Map dropdown menu.
Press [image: ] Finish to see the completed map on the report design grid.
[bookmark: _Toc468348370]Linked Reports
The ability to create drilldowns can be added by linking reports. Linked reports are only available in the Report Viewer or Dashboard Viewer.
The Linked Report menu contains three tabs: Report, Fields, and Formula.
[image: ]
Report
The Report tab allows you to select which report to link to.
· To link a report, select a cell and press the Linked Reports button [image: ]. The Linked Report Menu will appear. Select the report you want to link and press [image: ] OK.
· A cell with a linked report will be indicated a linked report icon [image: ]. You can click on this icon to bring up the Linked Report Menu for this cell.
· To unlink a report, right-click on the cell with the linked report, and select [image: ] Remove Linked Value.
· Or select the cell with the linked report and open the Linked Report menu. Press [image: ] then press [image: ] OK.
When a link is set on a cell, by default, the unique key of the information being displayed is used to automatically filter the linked report. In the example below, the linked report is filtered for information where Employee Last Name equals 'Buchanan'. Note that report and dashboard filters also affect the data within drilldowns.
Example
[image: ]
Fields
By default, the application will attempt to map the field contents of the linked cell to the same field in the linked report. (E.g. {Categories.CategoryID} <> {Categories.CategoryID}).
Using the Fields tab, you can specify which fields to link in order to map different fields with similar content. (E.g. {Categories.CategoryID } <> {Products.CategoryID}).
[image: ]
To add a custom link:
· Select the category to link from the parent report in the From Category dropdown.
· Select the category to link to within the linked report in the To Category dropdown.
· Press [image: ] Add and select the From and To Fields for each new link.
To remove a custom link, press [image: ].
Formula
The Formula tab allows you to specify a custom formula in order to further filter the data passed from the linked report. The formula must return True or False. The formula is evaluated for each row in the parent report, and if the condition is not met, the data is excluded from the linked report. See Formulas for more information.
[image: ]
· To add a Data Field, drag-and-drop it into the Formula box or double-click it. Or enter it manually using the format: {DataCategory.DataField}
Linked report formulas support a maximum of one data field. If multiple data fields are entered, all but the first will be ignored.
· To add a Parameter, enter it manually using the format: @ParameterName@
· To add a Function, drag-and-drop it into the Formula box or double-click it. Or enter it manually using the format: Function(variable1,variable2,...)
[bookmark: _Toc347472830]Chart Drilldowns
Chart drilldowns can also be created by using the Linked Reports menu. Chart drilldowns are only available in the Report Viewer or Dashboard Viewer.
· To create a drilldown, select a cell that contains a chart and press [image: ]. The Linked Report window will appear displaying the available reports. Select the report you want to link and press [image: ] OK.
· To remove a drilldown, select the cell with the linked report and open the Linked Report menu. Press [image: ] then press [image: ] OK.
Example
[image: ]
[bookmark: _Toc468348371]Gauges
A Gauge can be displayed in a report to give a visual representation of the scale of a value. To insert a Gauge, select a cell and press the Insert Gauge button ([image: ]). The Gauge Wizard will appear. The Gauge Wizard has two tabs: Appearance and Data.
Gauges can be placed in any section of the report.
Appearance
[image: ]
In the Appearance tab select the Type and Dimension of the Gauge.
Type – Select the icon representing the type of gauge. Available types include: Angular, Linear, Bulb and Thermometer.
There are three ways to set the size of the Gauge.
· Enter the Height and Width in the dimension boxes.
· Resize the gauge by dragging the lower right corner in the preview.
· Check Fit to Cell.
Data
[image: ]
In the Data tab select the Data Values and Color Ranges for the Gauge.
Use the Value and Range dropdown to select the cell that contains the numeric value for the Gauge.
Use the Provide range as buttons to specify if the Min and Max values for the Gauge should be static numbers or come from cells on the report.
In the Color Ranges, use the Color By buttons to specify if color ranges should be percentages of the Max value, static numbers, or come from cells on the report.
Percent Color Ranges must be in ascending numeric order.
Use the [image: ] Add and [image: ] Remove buttons to create additional colors. To change a color, either use the dropdown ([image: ]) or enter a Hex value.
Thermometer Gauges can only have one color.
[bookmark: _CrossTabs][bookmark: _Toc468348372]Crosstabs 
Crosstabs allow the report to expand both horizontally and vertically based on data values and display summary information where each column and row meets. Crosstabs can be entered into a Standard Report from the toolbar using the Crosstab Button ([image: ]). A Crosstab consists of three parts: Row Headers, Column Headers, and Tabulation Data. Additional settings for Crosstabs can be found in the Crosstab Options Menu.
The cells below and to the right of a cell containing a Crosstab must be empty.
[image: ]
[bookmark: _Row_Headers]Row Headers
Row Headers expand a Crosstab vertically. A Crosstab has a row for each unique value of a Row Header.
E.g. If you were using sales data, you may have the Row Headers Category.CategoryName and Products.ProductName to provide rows for each product grouped by category.
· To add a Row Header, either drag-and-drop the Data Field to the Row Header Source panel or select the Data Field and press [image: ].
· Use the Formula Editor Button ([image: ]) to insert a formula into the Row Header.
· Use the Edit Header button ([image: ]) to open the header options menu.
[image: ]

In the Header Options Menu you can:

· Set a Label for the Row Header. This label will appear at the top of the Crosstab.
· Select a Sorting Method and Direction:

· None – Does not sort the Row Header.
· Header Value (Text) – Sorts the Row Header by its values as though they are text.
· Header Value (Number) – Sorts the Row Header by its values as though they are numbers.
· Tabular Totals – Sorts the Row Header by the totals of the Tabulation Data.

If there is more than one Row Header the Header Options Menu for the top most Row Header will have Options for subtotals of Tabulation Data.
· Select where to display subtotals by using the Placement dropdown:

· None – Does not display subtotals.
· Top – Displays subtotals above the Tabulation Data for each Row Header value.
· Bottom – Displays subtotals below the Tabulation Data for each Row Header value.

· Set a Label for the subtotals.
· Use the up ([image: ]) and down ([image: ]) arrows to rearrange the order of the Row Headers.
· [bookmark: _Column_Headers]To remove a Row Header, press the delete button ([image: ]).
Column Headers
Column Headers expand a Crosstab horizontally. A Crosstab has a column for each unique value of a Column Header. 

E.g. If you were using sales data, you may have the Column Headers 'Year({Order.OrderDate})' and 'Month({Orders.OrderDate})' to provide columns for each month grouped by year.

· To add a Column Header, either drag-and-drop the Data Field to the Column Header Source panel or select the Data Field and press [image: ].
· Use the Formula Editor Button ([image: ]) to insert a formula into the Column Header.
· Use the Edit Header button ([image: ]) to open the header options menu.

[image: ]

In the Header Options Menu, you can:

· Set a Label for the Column Header to appear at the top of the Crosstab.
· Select a Sorting Method and Direction.
· None – Does not sort the Column Header.
· Header Value (Text) – Sorts the Column Header by its values as though they were text.
· Header Value (Number) – Sorts the Column Header by its values as though they were numbers.
· Tabular Totals – Sorts the Column Header by the totals of the Tabulation Data.

If there is more than one Column Header the Header Options Menu for the topmost Column, Header will have Options for subtotals of Tabulation Data.
· Select where to display subtotals by using the Placement dropdown.
· None – Does not display subtotals.
· Left – Displays subtotals to the left of the Tabulation Data for each Column Header value.
· Right – Displays subtotals to the right of the Tabulation Data for each Column Header value.
· Set a Label for the subtotals.
· Use the up ([image: ]) and down ([image: ]) arrows to rearrange the order of the Column Headers.
· [bookmark: _Tabulation_Data]To remove a Column Header press [image: ].
Tabulation Data
Tabulation Data provides information when data exists for the Column Header and Row Header values. For example, if you have a Row Header on products and a Column Header on the month, then Tabulation Data of Orders.OrderID may use the Count function to display how many orders contained each product each month.

· To add Tabulation Data, either drag-and-drop the Data Field to the Tabulation Data Source panel or select the Data Field and press [image: ].
· Use the Formula Editor Button ([image: ]) to insert a formula into the Tabulation Data.
· Use the Edit Header button ([image: ]) to open the Tabulation Options menu.

[image: ]

In the Tabulation Options Menu, you can:

· Set a Label for the Tabulation Row to appear at the beginning of each row.
· Use the Method dropdown to select the summary function to be applied to the Tabulation Data.

	Summary Functions
	· Sum: Totals the all of the data in the Tabulation Data.
· Count: Returns the number of rows in the Tabulation Data.
· Average: Takes the mean of the data in the Tabulation Data.
· Minimum: Displays the lowest value in the Tabulation Data.
· Maximum: Displays the highest value in the Tabulation Data.
· None: Displays the value in the Tabulation Data without doing any calculations.


· Use the Value dropdown to select how the Tabulation Data should be displayed.

· Aggregate: Display the result of the selected Method.
· Percent of Row: Display the result of the selected method as a percentage of the row total.
· Percent of Column: Display the result of the selected method as a percentage of the column total.

· Use the up ([image: ]) and down ([image: ]) arrows to move the Tabulation Data order.
· To remove a Tabulation Data field, press [image: ].
Crosstab Themes
The Theme dropdown can be used to quickly style the Crosstab using one of the pre-defined themes. Further styling can be done to the cells of the Crosstab in the Report Designer.
[bookmark: _CrossTab_Options]Crosstab Options
Settings that affect the entire Crosstab are controlled in the Crosstab Options menu.
[image: ]
Use the menu to adjust the following settings:
General
· Use the Row Headers Placement dropdown to determine how the Row Headers are displayed.
· Columns – Display the Row Headers in columns from left to right in their order in the Row Header Source panel.
· Hierarchical – Display Row Headers in a hierarchical structure using indentation to display their order.
· Check Repeat Crosstab Header every new page to repeat Row Header labels and Column Headers on each new page. 
Grand Total Row
· To get a total for each column, select Top or Bottom from the Placement dropdown and provide a label in the Label text box.
Grand Total Column
· To get a total for each row, select Top or Bottom from the Placement dropdown and provide a label in the Label text box.
[bookmark: _Toc468348373]Renaming Reports
[bookmark: _Editing_Data_Categories]To change the name of a report, select 'Rename' in the Toolbar dropdown menu. Enter a new name and select the folder in which you want to save the report. Press [image: ] OK.
[image: ][image: ]
[bookmark: _Toc468348374]Changing Description
The report description appears at the bottom of the Main Menu. Report descriptions are optional but can be searched. To change a report description, select 'Description' in the Toolbar dropdown menu. Write a description and press [image: ] OK.
[image: ][image: ]
[bookmark: _Data_Categories][bookmark: _Toc468348375]Changing Data Categories
In the Categories Tab, select the Data Categories that you would like to have access to on the report. It is important to understand two terms: Data Category and Data Field.
Data Category – A Data Category is a data object that has several attributes. E.g. Orders is a category; each order has an ID, a date, a customer, etc.
Data Field – A Data Field is a single attribute within a category. E.g. Orders.OrderID is numeric value that identifies a specific order.
· To add a Data Category, either drag-and-drop it to the selection pane, or select the Category and press [image: ] Add or [image: ], or double-click the Category.
· To search for a Data Category or folder, enter text into the search bar.
· To see the Data Fields in a Data Category, select the Category and press [image: ].
· Check Suppress Duplicates to suppress any repeated records from that Category.
· To remove a Data Category, press [image: ].
[image: ][image: ]
[bookmark: _Changing_Sorts][bookmark: _Toc468348376]Changing Sorts
To modify the sort criteria of a report, select 'Sorts' in the Toolbar dropdown menu.
In the Sorts Tab, specify which Data Fields will be used to determine the order of data on the report.
· To sort by a Data Field, either drag-and-drop it to the selection pane, or select the Data Field and press [image: ] Add or [image: ], or double-click the Category.
· To sort by a Formula, press [image: ] Add Formula. To edit an existing formula, press [image: ]. See Sorting by Formula for more information.
· You can order each sort in Ascending (A-Z, 0-9) or Descending (Z-A, 9-0) order.
· Use the up ([image: ]) and down ([image: ]) arrows to indicate the sort priority.
· To remove a sort, press [image: ].
[image: ][image: ]
[bookmark: _Sorting_by_Formula]Sorting by Formula
To sort and group by information that may not be contained within an individual data field, you can use Formulas. See Formulas for additional help.
Press [image: ] Add Formula or the Formula Editor ([image: ]) button to open the Formula Editor window:
[image: ]
· To add a Data Field, drag-and-drop it into the Formula box or double-click it. Or enter it manually using the format: {DataCategory.DataField}
· To add a Parameter, enter it manually using the format: @ParameterName@
· To add a Function, drag-and-drop it into the Formula box or double-click it. Or enter it manually using the format: Function(variable1,variable2,...)
For example, say I had a data field containing a full date and time, and I wanted to analyze my sales by each month of the year over a multi-year period.
I could use the formula Month({Orders.OrderDate}) to return only the Month component of each date. Then I could sort my sales by Month.
[bookmark: _Toc468348377]Changing Filters
To modify the filter criteria of a report, select 'Filters' in the Toolbar dropdown menu. There are three types of filters: Standard, Interactive, and Group. Standard filters are based on values you specify. Interactive filters can be applied after running a report to the Report Viewer. Group filters are based on the minimum or maximum value in the Data Field.
[bookmark: _Standard_Filters_1]Standard Filters
There is no limit to the number of filters that can be defined. Filters can be numeric (up to eight decimals) or alphanumeric.
· To filter by a Data Field, either drag-and-drop it to the selection pane, or select the Data Field and press [image: ] Add or [image: ], or double-click the Data Field.
· Use the up ([image: ]) and down ([image: ]) arrows to indicate the filter priority.
· To remove a filter, press [image: ].
· Select the operator (Equal To, Less Than, One Of, etc.) from the operator dropdown.
· Set the filter value either by entering it manually or by selecting a value from the filter dropdown. If the Data Field is a date, the calendar and function buttons can be used to select a value.
· Check Prompt for Value to allow the filter to be modified at the time the report is run.
· Select AND With Next Filter to require that the selected filter and the one below it both evaluate to true. Select OR With Next Filter to require that either one be true.
· Check Group With Next Filter to specify the precedence of the filters. Filters can be nested indefinitely by using the following keyboard shortcuts while a filter is selected:
· Ctrl + [ adds an open-parenthesis before the selected filter.
· Ctrl + ] adds a close-parenthesis after the selected filter.
· Ctrl + Shift + [ removes an open-parenthesis from before the selected filter.
· Ctrl + Shift + ] removes a close-parenthesis from after the selected filter. 
[image: ][image: ]

[bookmark: _Interactive_Filters]Interactive Filters
Interactive Filters can be created in the Report Viewer Options Menu. These filters can be enabled, disabled, or modified after running a report to the report viewer. For more information, see Interactive Report Viewer Options.
[bookmark: _Report_Options]Group (Min/Max) Filters
Group Min/Max filters will cause the report output to display detail containing either the highest or lowest values in a field for either one group, multiple groups, or an entire data set. This is useful if you are only interested in viewing the highest or lowest values — such as the most recent hire date or highest revenue figure — in a given set. Group Min/Max filters are mutually exclusive with standard filters, and there is no limit to the number of group filters you may define.
[image: ]
To modify group filters, click 'Switch to Group (MIN/MAX) filters' . There is no limit to the number of group filters you may define.
[image: ]
· To filter by a Data Field, either drag-and-drop it to the selection pane, or select the Data Field and press [image: ] Add or [image: ], or double-click the Data Field.
· Specify Minimum or Maximum from the operator dropdown.
· Specify whether to apply the filter to each Category or Sort field. To apply the filter to only the selected group, check Ignore other groupings on report.
Selecting 'Entire Data Set' causes the Min/Max filter to apply across the entire report and ignore any other groupings.
· Use the up ([image: ]) and down ([image: ]) arrows to indicate the filter priority.
· To remove a filter, press the delete button ([image: ]).
[bookmark: _Toc468348378]General Options
Hover over 'Options' in the Toolbar dropdown and then select the 'General' menu to open the Report Options Window. This window allows you to control various settings including default export type and page orientation.
[image: ] [image: ]
General Options
· Use the Default Export Type dropdown to specify the default format for the report.
· From the Include Setup menu, select Top or Bottom to display the data categories, sorts, and filters at either the beginning or end of the report.
· Output types may be disabled by unchecking the boxes for Allowed Export Types.
· Use the Filter Execution Window dropdown to select which type of Filter menu displays when executing a report that has prompt-for-value filters.
· Default – Display the default type of filter execution window.
· Standard – Display the standard filter execution window.
· Simple with Operator – Display a simplified filter execution window that only allows the operator and value to be changed.
· Simple without Operator – Display a simplified filter window that only allows the filter value to be changed.
· Check Always Show Filter Execution to show the filter menu and allow changes to be made each time the report is executed.
· Use the No Data Qualify Display Mode to select what to display if no data qualifies for the report.
· Show Message – Display the standard no data qualified message.
· Show Report – Display the Page Header, Page Footer, Report Header, and Report Footer sections of the report. Any cells containing Data Fields will not be displayed.
Excel Options
· Check Suppress Formatting to prevent the report formatting from exporting to Excel.
Page Options
· Specify the size for the report in the Page Size menu. Default is Letter.
· Set the orientation for the report in the Orientation menu. Default is Portrait.
· Check Fit to Page Width to scale all columns to fit the width of the page.
[bookmark: _Interactive_HTML_Options_1][bookmark: _Toc468348379]Report Viewer Options

Hover over 'Options' in the Toolbar dropdown and then select 'Report Viewer' menu to open the Report Viewer Options Menu. This window allows you to control what interactive capabilities a user has when viewing reports.
[image: ] 
General
[image: ]

Uncheck Show Grid to disable grid lines.
Uncheck Simulate PDF to have the report appear as though it is not on a page.
Uncheck Allow Hide/Show Columns on Execution to disable the Hide Columns tools.
Filters
[image: ]
Interactive Filters are filters created on either Data Fields or Formulas and then enabled after running a report to the report viewer.
· To filter by a Data Field, either drag-and-drop it to the selection pane, or select the Data Field and press [image: ] Add or [image: ], or double-click the Data Field.
· To filter by a formula, first add a Data Field, then use the formula button ([image: ]) to open the Formula Editor.
· In the Title box provide a name for the interactive filter.
· Use the Type dropdown to specify what kind of interactive filter to display:
· Single Choice - A dropdown with the possible values of the filter:

[image: ]

· Multiple Choice - All possible values for the filter presented with check boxes to select one or more values:

[image: ]

· Single Slider - Select the filter value by sliding a point along a scale:

[image: ]

· Range Slider -  A scale that displays values between two points:
[image: ]
· Press the Format button ([image: ]) to open the format menu and specify how the filter values should be displayed.
· If filtering on an Aggregate formula such as AggSum, use the Calculate Value Every dropdown to select on which sorted field or category the aggregate should be applied.
· Use the Value Sort Direction to specify if the filter values should display in ascending or descending order.
· Check Initially Display Filter on Panel to have the filter enabled automatically when the report is run to the viewer.
Sorts
[image: ]
Interactive sorts can be used to change the direction of a report's Sorts while viewing the report in the Report Viewer
· Uncheck Display sorts in Report Viewer to hide interactive sorts in the Report Viewer.
· In the Title column, provide a name for each interactive sort.
[bookmark: _Toc468348380]Advanced Options
Select 'Advanced' in the Toolbar dropdown menu to open the Advanced Options window. This window allows you to specify additional information about how the Data Categories relate to each other.
[image: ] [image: ]
Before using these options, it is important to understand the definition of a Join.
Join – A join defines how two Data Categories are related. Each join has a 'From' Category and a 'To' Category. The From and To objects must have one (or more) Data Fields that contain the same information.
E.g. A join exists between two Data Categories: Orders and Customers. The join goes 'From' Customers 'To' Orders. In this example, when a customer makes an order, that customer's ID is saved with the order. Thus, the Orders Category has the Data Field CustomerID. This Data Field matches the Data Field CustomerID in the Customers Category. This join assures that each customer is paired with the orders that they have made.
· To add a new join, press [image: ] Add.
· To edit a join, press [image: ].
· Restore the default joins by pressing [image: ].
· To remove a join, press [image: ].

When you press the Add or Edit buttons, the Report Join menu will appear. In this menu, you can create or modify a Join for the report:
[image: ]
· To set the From Category, drag-and-drop the Data Field into the Join From panel or select the Data Field and press [image: ] Add From.
· To set the To Category, drag-and-drop the Data Field into the Join To panel or select the Data Field and press [image: ] Add To.
· Use the up ([image: ]) and down ([image: ]) Arrows to reorder the Data Fields. The position of each Field in Join From should match the position of its corresponding Field in Join To. 
[bookmark: _Toc296683247][bookmark: _Toc306613075][bookmark: _Toc468348381][bookmark: _Toc296683284][bookmark: _Toc306613107][bookmark: chapter_03_editing_reports_pdf_t_9383][bookmark: chapter_03_editing_reports_pdf_t_5425]Document Template
Reports can also be used to fill in PDF, RTF, or Excel templates, such as internal or government documents. Select 'Templates' in the dropdown menu to open the Document Template window.
· Before using the Templates window, put your data into the cells of your report.
· From the top dropdown, select the template you want to use.
· In the 'Report Field' column, specify which cell of the report corresponds to each 'Template Field'.

Once the fields are complete, exporting the report in the same format as the template will produce a filled-in template.

The example below shows the fields being set in the Document Template window and the output when the report is exported as a PDF.
[image: ]
[image: ]
[bookmark: _Creating_and_Editing][bookmark: _Toc468348382]Duplicating Reports

Duplicating reports can save time. This feature creates a new report that is identical to an existing one. Instead of creating the new report from scratch, you can duplicate an existing report, rename it, and make your changes.
1. On the Main Menu, select the report you want to duplicate.
2. Press [image: ]. The Rename Report Window will open.
3. Type the name of the new report into the Report Name field.
4. [bookmark: __RefHeading__11263_1934010483][bookmark: _Deleting_Reports]Select which folder to save the report.
5. Press [image: ] OK.
[bookmark: _Toc468348383]Deleting Reports 

Deleting a report removes the report and all of its components.
To delete an existing report:
1. On the Main Menu, select the report you want to delete.
2. Press [image: ]. A dialog box will ask if you are sure you want to proceed.
3. Press [image: ] OK to delete the report.
IMPORTANT. Once the report is deleted, there is no way to recover it.
[bookmark: _Scheduling_Reports][bookmark: _Toc468348384]Scheduling Reports 

Reports may be sent to recipients via email using custom scheduled intervals. A scheduled report can be executed and emailed immediately or scheduled to be emailed on a recurring basis. The Scheduler Menu lets you schedule and email reports or edit existing schedules.
To open the Scheduler Menu:
1. In the Main Menu, select the report you want to schedule/email.
2. Press [image: ]. The Schedule Menu will appear.

[image: ]

· To schedule a report, press [image: ] Schedule Report. The  Schedule Report Wizard will open in a new tab.
· To email a report, press [image: ] Email Report. The Email Report Menu will appear.
· To edit existing schedules, press [image: ] Manage Scheduled Reports. The Schedule Manager will open in a new tab.
If you do not see a Schedule Report button in the Main Menu, then you do not have Report Scheduler permissions and should contact your administrator.
[bookmark: _Schedule_Report_Wizard][bookmark: _Create_Report_Schedule][bookmark: _Report_Schedule_Wizard][bookmark: _Toc468348385]Schedule Report Wizard
The Schedule Report Wizard has five sub tabs. The Recurrence and Recipients tabs are required, and the other tabs are optional.
1. Recurrence: Specify the name and format of the report and when the report should be sent out.
2. Parameters: (optional) Set values for any parameters used by the report.
3. Filters: (optional) Add filters to the report.
4. Batch: (optional) Set a list of recipients each of whom will receive a unique filtered version of the report.
5. Recipients: Specify the recipient addresses, subject, and body text of the email.
[bookmark: _Recurrence_Tab][bookmark: _Toc468348386]Recurrence Tab
[image: ]
In the Recurrence Tab, give the schedule a name and format. Set the frequency at which you want the report to be executed and sent out. This recurrence can be a one-time, daily, weekly, monthly, or yearly delivery. A date range can also be set to give the report delivery a defined start and end date.
· Give the Schedule a Name and select an Export Type from the dropdown.
· For PDF reports, a Password may be set. The password may require a minimum number of upper/lowercase letters or numbers. To find out the required password strength, hover the mouse over the Password box.
· To execute and send the report immediately, check Execute Immediately.
· Schedule Time
· Set the time of day the report should be executed by entering a time in the Schedule Time box.
· Check Repeat every and then specify a time interval to have the schedule be sent on a recurring basis on the day(s) specified in as the Recurrence Pattern.
· Recurrence Patterns
· Once – Specify to execute the report on a specific day or immediately.
· Daily – Send the report every weekday or every set number of days.
· Weekly – Send the report on specific days of the week.
· Monthly – Set the day of the month to send the report.
· Yearly – Set the day of the year to send the report.
· Range of Recurrence 
· Use the Range of Recurrence section to set a start date and an end date for the report schedule.
[bookmark: _Parameters_Tab][bookmark: _Toc468348387]Parameters Tab
[image: ]
In the Parameters Tab, enter a value for each of the parameters listed.
The Parameters Tab will only be visible if the report is utilizing parameters. See Parameters for more information.
[bookmark: _Filters_Tab][bookmark: _Toc468348388]Filters Tab
[image: ]
There is no limit to the number of filters that can be defined. Filters can be numeric (up to eight decimals) or alphanumeric.
· To filter by a Data Field, either drag-and-drop it to the selection pane, or select the Data Field and press [image: ] Add or [image: ], or double-click the Data Field.
· Use the up ([image: ]) and down ([image: ]) arrows to indicate the filter priority.
· To remove a filter, press [image: ].
· Select the operator (Equal To, Less Than, One Of, etc.) from the operator dropdown.
· Set the filter value either by entering it manually or by selecting a value from the filter dropdown. If the Data Field is a date, the calendar and function buttons can be used to select a value.
· Check Prompt for Value to allow the filter to be modified at the time the report is run.
· Select AND With Next Filter to require that the selected filter and the one below it both evaluate to true. Select OR With Next Filter to require that either one be true.
· Check Group With Next Filter to specify the precedence of the filters. Filters can be nested indefinitely by using the following keyboard shortcuts while a filter is selected:
· Ctrl + [ adds an open-parenthesis before the selected filter.
· Ctrl + ] adds a close-parenthesis after the selected filter.
· Ctrl + Shift + [ removes an open-parenthesis from before the selected filter.
· Ctrl + Shift + ] removes a close-parenthesis from after the selected filter.
[bookmark: _Batch_Tab][bookmark: _Toc468348389]Batch Tab
[image: ]
Check Run as Batch Report to enable batch execution for the report.
If you don't see this option, your administrator may have disabled it.
Reports can be executed and emailed en masse to a list of addresses, each one filtered by a unique key. E.g. A report containing data on a number of employees may be run such that each employee receives an email containing a version of the report filtered on their own unique ID.
In order to use batch reporting, a table or other data structure must exist which contains a list of email addresses each associated with a key used to filter the report. Each row may contain optional columns that can be used as parameters in the email message body (using the form @batch_columnName@).
	Key
	Email Address
	OptionalCol1
	OptionalCol2



The email address table must have a join path defined to a table in the report. It does not need to be added to the report.
· Enter an (optional) Batch Summary Email to send an email which will summarize the result of the batch report execution.
· In the Batch Email Field select the field in the email address table which contains the addresses to use when sending the completed reports.
[bookmark: _Group_(Min/Max)_Filters_1][bookmark: _Recipients_Tab][bookmark: _Toc468348390]Recipients Tab
[image: ]
In the Recipients Tab, determine how the schedule will be delivered and list the email address(es) to which the report should be sent. Separate email addresses with a semi-colon (;).
· Check Email Results to have the report sent via email. Uncheck this option to have it saved to a repository.
· An Attach Report Output to Email checkbox will be available when using batch reporting. Uncheck this option to prevent the reports from being attached to the recipient emails.
· In the To field, set the email address(es) to which the report will be delivered.
· In the Cc field, set any address(es) to be carbon copied.
· In the Bcc field, set any address(es) to be blind carbon copied.
When using batch reporting, the To, Cc, and Bcc fields are disabled.
· Set the subject of the email in the Subject field.
· In the Body field, enter the text of the email to be sent with the report. To reference the report name use @reportName@. To reference any batch parameters, use @batch_columnName@, where columnName is a column in the email address table.

[bookmark: _Email_Report]@reportName@ is a built-in parameter. See Parameters for more information.

[bookmark: _Toc468348391]Email Report
Reports can be emailed quickly to a single address using the Email Report menu.
[image: ]
In the [image: ] Scheduler Menu, hover over [image: ] Email Report. An input field will appear.
· In the input field, enter the email address.
· Press the [image: ] dropdown to select a format for the report.
· Select a format to email the report.
[bookmark: _Manage_Scheduled_Reports]Reports can only be emailed as downloadable file types (Excel, PDF, RTF, CSV).

[bookmark: _Toc468348392]Manage Scheduled Reports
Scheduled Reports can be monitored, edited, and removed using the Scheduled Reports tab.
[image: ]
In the [image: ] Scheduler Menu press [image: ] Manage Scheduled Reports. The Scheduled Reports tab will open.
· Click at the top of a column to sort the scheduled reports by that column.
· To update the status and list new schedules press [image: ] Refresh.
· To removed completed schedules press [image: ] Flush.
· Press [image: ] to open the Schedule Report Wizard and modify the report.
· To delete a schedule press [image: ].
[bookmark: _Running_Reports][bookmark: _Executing_Reports][bookmark: _Toc468348393]Executing Reports 

Reports can be run or exported from the Main Menu or the Report Designer.
In the Main Menu select the report you want to run or export. With the report highlighted press the Run Report button [image: ]. To change the output format, press the Export Type dropdown [image: ] and select from the available export formats (Excel, PDF, RTF, or CSV).
Right-clicking on the Export Type button will export the report to a PDF.
[image: ][image: ]
In the Design Tab, press the Run Report button [image: ]. To change the output format, press the Export Type dropdown [image: ] and select from the available export formats (Excel, PDF, RTF, or CSV). See Report Options to change the default format for the report:
[image: ]
[bookmark: _Interacting_with_HTML][bookmark: _Toc468348394]Interacting with Reports
After running a report in the Report Viewer, you can make further modifications to the report's style, formatting, and content. These changes can be exported to other formats, saved to the original report, or saved as a separate copy of the report depending on the settings.
For these interactions to be available, they must be enabled in the Report Viewer Options Menu in the Report Designer.
[bookmark: _Toc468348395]Changing Styling
While viewing a report in the Report Viewer, right click a cell to open the style menu. Using this menu, you can change font, size, foreground and background color, bold, italic, underline, and alignment options.
[image: ]
[bookmark: _Toc468348396]Resizing Columns
The columns of a report can be resized by dragging the light grey bar at the top of the page to the desired size.
[image: ]
[bookmark: _Applying_Interactive_Filters][bookmark: _Toc468348397]Applying Interactive Filters
Any available interactive filters can be enabled by pressing the add button ([image: ]) in the Filters section of the Interactive Report Viewer dock, which is located next to the report.
Interactive filters must be defined in the Interactive Report Viewer Options Menu. Additional filters can be created directly on the report by right-clicking within the Report Viewer. See Conditional Filters for more details.
[image: ]
After enabling a filter use the checkbox, dropdown, or slider to select what values should appear on the report. After selecting a value, the report will refresh with the filter applied. 
Press [image: ] to remove an active filter. The report will refresh to deactivate the filter.

[image: ]
[bookmark: _Conditional_Filters][bookmark: _Toc468348398]Conditional Filters
You can set filters on specific values in addition to the pre-defined interactive filters by interacting with the report in the Report Viewer.
To create a conditional filter, right-click on a cell of the report, choose an operator from the 'Apply To' dropdown then press the filter button ([image: ]):
[image: ]
The conditional filter will appear in the dock below the interactive filters and sorts:
[image: ]
[bookmark: _Changing_Sorts_1][bookmark: _Toc468348399]Changing Sorts
[bookmark: _Saving_Changes]In the dock next to the report you can change the direction of any sorts on the report by pressing the ascending ([image: ]) and descending ([image: ]) buttons:

[image: ]

Additionally, you can sort by individual columns of the report by clicking on the light grey bar at the top of the page:

[image: ]
[bookmark: _Hiding_Columns][bookmark: _Toc468348400]Hiding Columns
In the dock next to the report, you can show/hide the columns of the report by checking/unchecking the column names:

[image: ]
[bookmark: _Toc468348401]Saving & Clearing Changes
Changes to styling, column sizes, sorts, and filters can be saved in a number of ways.
[image: ]
In the toolbar above the report:
· Using the Clear dropdown ([image: ]), you can remove any changes made to the report.
· Use the Save button ([image: ]) to save interactive changes onto the report.
· Use the Save as New Report button ([image: ]) to make a copy of the report with the changes.
· Use the 'Save Changes as User Report' option under the 'Save Options' dropdown to save your changes as a User Report. The changes will be applied each time you run the report but will not be seen when the same report is run by another user.
· Use the 'Delete User Report' option under the 'Save Options' dropdown to remove any changes that were saved as User Report.
[bookmark: _Toc468348402]Exporting to Other Formats
From the Report Viewer, you can export a report, including any interactive changes, to other formats such as Excel, PDF, RTF, or CSV. To do so, use the export button in the toolbar above the report and selected the export format.
[image: ]
[bookmark: _Creating_and_Editing_1][bookmark: _Toc468348403]Creating and Editing Dashboards

Dashboards provide a canvas that can display reports, data visualizations, images, text and web pages.
To create a new dashboard, press [image: ] (New Report) in the Main Menu, then select [image: ] Dashboard. The Dashboard Designer will appear in a new tab.
[image: ]
[bookmark: _Dashboard_Designer][bookmark: _Toc468348404]Dashboard Designer
The Dashboard Designer can be used to add reports, text, images, and web pages to a dashboard.
The Dashboard Designer has four components: the Design Canvas, Tool Box, Data Fields, and the Toolbar.
[image: ]
Dashboard Canvas
In the Dashboard Designer, you can:
· Move and resize Dashboard Items
· Style Dashboard Items with alignment, borders, colors, etc.
· Edit Dashboard Items such as Reports, Data Visualizations, and Text
Toolbox
By dragging Dashboard Items from the Toolbox onto the canvas, you can add the following:
· Reports
· Data Visualizations
· Text
· Images
· Web Pages
· Interactive Filters
Data Fields
After dragging a Data Visualization from the Toolbox on to the Canvas, you can add Data Fields by dragging them over the Data Visualization.
Toolbar
Using the toolbar, you are able to:
· Rename the Dashboard and modify its description
· Set the Dashboard to automatically run when entering this tool
· Change the background color of the canvas
· Format the font, font size, alignment, color, and borders of text
· Save the dashboard
· Run the dashboard to the Dashboard Viewer
[bookmark: _Toc468348405]
Dashboard Items
By dragging Dashboard Items onto the canvas, you can add the following items to the dashboard:
· Reports
· Dashboard Visualizations
· Text
· Images
· Web Pages
· Interactive Filters
[bookmark: _Adding_Reports]Adding Reports
To add an existing report to the dashboard, drag-and-drop the Report Button ([image: ]) over the Dashboard Canvas. The Report Properties menu will appear. The Report Properties menu has four tabs: Report, Filters, Parameters, and Options.
Report
In the Reports Tab, select the report you want to display on the dashboard.
[image: ]
Filters
If the selected report has any Prompt for Value Filters, those filters will appear in the Filters tab. In this tab, you can specify how to prompt for these filter values.
[image: ]
For each Filter:
· Use the Action dropdown to select how the filter should prompt.
· Dashboard Prompt – When the dashboard runs, you will be prompted for a value that is used by all of the reports on the dashboard that filter using this Data Field.
· Report Prompt – When the dashboard runs, you will be prompted for a value to filter this specific report.
· Assign Value – Assign the filter a specific value. This filter will not prompt when the dashboard runs.
· In the Data (Prompt Text or Value) column, enter a value if the Action is Assign Value; if the Action is Dashboard or Report Prompt, enter text to use for the prompt.
Parameters
If the selected report has any Prompting Parameters, those parameters will appear in the Parameters Tab. In this tab, you can specify how to prompt for these parameter values.
[image: ]
For each Parameter:
· Use the Action dropdown to select how the parameter should prompt.
· Dashboard Prompt – When the dashboard runs, you will be prompted for a value that is to be used by all of the reports on the dashboard with that parameter.
· Report Prompt – When the dashboard runs, you will be prompted for a value that is used by this specific report.
· Assign Value – Assign the parameter a run value and do not prompt when the dashboard runs.
· In the Data (Prompt Text or Value) column, enter a value if the Action is Assign Value; if the Action is Dashboard or Report Prompt, enter text to use for the prompt.

Options
In the Options Tab, specify settings for how the report displays on the dashboard.
[image: ]
Report Viewer
· In the Report Label field, provide a title for the report. This title will be displayed in on the canvas when editing the dashboard.
· Check Allow scrolling to allow scrolling on the dashboard if the report is larger than the designated size on the canvas.
· Set the number of seconds at which to re-run the report. Set to 0 to only run the report when the dashboard is first run.
Design
· Check Only run report in design screen when report is manually refreshed to prevent the report from being run accidentally while editing the dashboard.
Adding Data Visualizations
To create a new Visualization on the dashboard, drag-and-drop the Data Visualization icon ([image: ]) onto the Dashboard Canvas. A Data Visualization item will appear.

[image: ]

With the Data Visualization item, you can:
Drag Data Fields onto the item to create a chart or a tabular report.
Use the Options Menu ([image: ]) to filter, name, or modify other settings of the Visualization.
Modify how the Data Fields are grouped and summarized by opening the Data Model Menu ([image: ]).
Save the Data Visualization as a new Standard Report ([image: ]).
Subsequent changes in the Standard Report Designer will not be reflected on the Data Visualization. To have those changes appear on the dashboard, add the new report to the dashboard.
Convert from a chart to tabular report (or vice versa) by selecting 'Convert to Chart' in the right-click menu.
A Data Visualization must have at least two Data fields, one of which must be numeric, in order to display a chart.

Adding Text
To add text to the dashboard, drag-and-drop the Text icon ([image: ]) over the Dashboard Canvas. A text box will appear. Type the desired text in this box. Use the Toolbar  to format the text.

[image: ]

Adding Images
To add an image to the dashboard, drag-and-drop the Image icon ([image: ]) over the Dashboard Canvas. An image box will appear. Press the insert image button ([image: ]) and select the image to upload.

[image: ]
Adding Web Pages
To add a web page to the dashboard, drag the URL Button ([image: ]) over the Dashboard Canvas. A URL menu will appear. Enter the desired URL and press [image: ].

Some web pages do not permit being embedded within another web page.

[image: ]

Adding Interactive Filters
[bookmark: _Toolbar_1]To add an interactive filter to the dashboard, drag-and-drop the Filter icon ([image: ]) over the Dashboard Canvas. The Filter Properties menu will appear. The Filter Properties menu has two tabs: Dashboard Items and Filter.

Dashboard Items
In the Dashboard Items Tab, select which reports and data visualizations the filter should apply to by checking the box in the Controlled column.
All of the reports and visualizations being controlled by the filter must share at least one common Data Category. Interactive filters will apply to the drilldowns on selected reports.
[image: ]
Filter
In the Filter Tab, specify what data should be used and how the interactive filter should appear on the dashboard.
[image: ]
· Use the Filter Value dropdown to select the data field that should be filtered.
The filter can be applied to a calculation instead of a data field by using the formula button ([image: ]).
· Use the Type dropdown to specify what kind of interactive filter to display:
· Single Choice: A dropdown with the possible values of the filter.

[image: ]

· Multiple Choice: All possible values for the filter presented with check boxes to select a one or more values.

[image: ]

· Single Slider: Select the filter value by sliding a point along a scale.

[image: ]

· Range Slider:  A scale that displays values between two points.

[image: ]
· In the Style dropdown, specify if the filter should be Vertically or Horizontally oriented.
· In the Value Sort Direction dropdown, specify if the filter values should appear from least to greatest (Ascending) or vice versa (Descending).
· Press the Format button ([image: ]) to open the format menu and specify how the filter values should be displayed.
[bookmark: _Toc468348406]Toolbar

The toolbar contains the buttons and menus used to modify the dashboard.
Saving Dashboards
The dashboard can be saved by pressing the save button ([image: ]).
Undo/Redo
Actions can be undone by pressing the undo button ([image: ]) or using the keyboard shortcut Ctrl+Z. Undone actions can be redone by pressing the redo button ([image: ]) or using the keyboard shortcut Ctrl+Y.
Borders
To create borders around a dashboard item, select it and press the Format icon ([image: ]).
[image: ]
· Uncheck Make Borders Uniform to modify specific edges.
· To widen the borders, enter a value (in px), or use the arrows in the width box.
· To change the color, click the color picker and select a color, or enter a Hex value.

Borders can be rounded by pressing the 'Rounded Edges' button ([image: ]) in the toolbar.
[bookmark: _Formatting_Dashboard_Items]Formatting Dashboard Text
Text items can be formatted using buttons in the toolbar. A text item must be selected for these changes to be applied.
Font
· To change the font, use the font dropdown ([image: ]). The font names appear in the style that they represent.
· The B, I, and U icons make the font bold, italicized, and underlined, respectively.
· Text size can be controlled using the up and down arrows on font size menu ([image: ]).
Color
· To change the text color, press the Foreground Color button ([image: ] ), and then select a color or enter a hex value into the Foreground box. Press the clear button ([image: ]) to revert to the default color.
· To change the background color, press the Background Color button ([image: ]) and then select a color or enter a hex value into the Background box. Press the clear button ([image: ]) to revert to the default color.
Alignment
· Text can be aligned to the top, center, or bottom of a cell using the vertical alignment buttons.
[image: ]
· Text can be centered, justified, or aligned to the left or right of a cell using the horizontal alignment buttons.
[image: ]


Renaming Dashboards
To change the name of a dashboard, select 'Rename' in the Toolbar dropdown menu. Modify the name and select the folder where the Dashboard will be saved. Press [image: ] OK.
[image: ][image: ]

Changing Description
The dashboard description appears at the bottom of the Main Menu. Dashboard descriptions are optional, but they are utilized when searching reports. To modify a dashboard description, select 'Description' in the Toolbar dropdown menu. Enter a description and press [image: ] OK.
[image: ][image: ]    
Dashboard Options
Select 'Options' in the Toolbar dropdown menu to open the Dashboard Options Window.
[image: ][image: ]
· To change the background color of the dashboard canvas, select a color or enter a hex value.
· Check Show report title bar on execution to allow reports on an executed dashboard to be selected and modified.
Running Dashboards
Dashboards can be run from the Main Menu or the Toolbar. To run a dashboard from the Main Menu, first select the dashboard you want to run and press the 'Run Selected Report' button.

[image: ]

When editing a dashboard, press the 'Run Dashboard' button to run the dashboard.
[image: ]
[bookmark: _Creating_Chained_Reports][bookmark: _Toc468348407]Chained Reports

Chained Reports comprise multiple component reports, which run in a specified order and compile into a single document.
Chained Reports can only be exported as downloadable file types (Excel, PDF, RTF, or CSV). Viewer-only features are not supported.

Chained Reports do not support Excel templates. All RTF reports in a chained report must share a common template.
[bookmark: _Chained_Report_Wizard][bookmark: _Toc468348408]Chained Report Wizard
The Chained Report Wizard is an interactive tool which allows you to create and edit Chained Reports.
Navigate between the tabs by clicking on the tab, or by using the [image: ] Previous and Next [image: ] buttons.
To save a Chained Report, press [image: ].
The Chained Report Wizard has three sub tabs. The Name and Reports tabs must be completed.
[bookmark: _Toc468348409]Name Tab
[image: ]
In the Name tab, enter a name and select the folder to save the report.
The report name can be up to 255 characters long. Avoid special characters such as ? : / \ * “ < >.
A report's description appears at the bottom of the Main Menu when it is selected. You may also search by a report's description text.
You cannot create a report inside a folder that is read-only ([image: ]).
[bookmark: _Toc468348410]Reports Tab
[image: ]

In the Reports Tab, select the component reports you wish to include in the Chained Report.

You can only include Standard Reports, Express Reports, and Crosstab reports in a Chained Report.
· To add a component report, either drag-and-drop it to the selection pane, or select the report and press [image: ] Add, or double-click the report.
· To search for a report by name or description, enter text into the search bar.
· A component report may be able to export only in certain formats. Available formats for each component report are listed under Available Export Types. A Chained Report which contains a format restriction on a component report cannot export to that format.
· If a component report has Prompt for Value filters or parameters, press [image: ] to access the Report Properties menu, where you can specify how to prompt for these filter values:
· Common Prompt – When the Chained Report is run, you will be prompted for a value that is used by all of the reports on the Chained Report that have filter prompts on this Data Field.
· Report Prompt – When the Chained Report executes, you will be prompted for a value to filter this specific component report.
· Assign Value – Assign the filter a specific value. This filter will not prompt when the Chained Report executes.
· Use the up ([image: ]) and down ([image: ]) arrows to indicate the order of the reports.
· To remove a report, press [image: ].
[bookmark: _Toc468348411]Options Tab
[image: ]
The Options Tab allows you to control various options for the chained report.
General Options
· Use the Default Export Type menu to specify the default format for the chained report.
· [bookmark: _Formulas]Output types may be disabled by unchecking the boxes for Allowed Export Types.
· Use the No Data Qualified Action menu to select what to display if no data qualifies for a component report.
· Skip Report – Display the next qualified report.
· Show Placeholder – Show a placeholder message in place of the report.
· Check Collate Reports to enable report collation.
Component reports must have a common sort field in order to collate. The sort field is used to organize the data into common groups, which determine how the chained report is ordered.
With collation Disabled (default) the chained report is ordered in the following manner:
	Filter
	Output

	Report 1
	Page 1

	
	Page 2

	Report 2
	Page 1

	
	Page 2



With collation Enabled the chained report is ordered in the following manner. Note that each component report is filtered by the common sort group.
	Output
	Filter

	Report 1
	Sort group 1

	Report 2
	

	Report 1
	Sort group 2

	Report 2
	



· Check Page break after each report to cause new reports to start on a new page.
[bookmark: _Formulas_1][bookmark: _Toc468348412]Formulas

[bookmark: __RefHeading__11293_1934010483]Formulas allow you to do calculations, parse strings, insert images, and much more. Formulas are the composition of functions, parameters, Data Fields, and references to other cells.
[bookmark: _Toc306613109][bookmark: _Toc468348413]Functions
Functions must begin with an '=' sign. You can use more than one function in each cell. Additionally, there are logical functions that allow for if/then/else conditional statements. Functions include date, financial, information, logical, mathematical, statistical, text, and data.
Function names are not case sensitive (aggSum is the same as AggSum).
For a complete list of functions, including description, remarks and examples, refer to Full Description of Functions.
[bookmark: _Parameters][bookmark: _Toc306613110][bookmark: _Toc468348414]Parameters
To call a parameter, enter its name between '@' signs. Parameters can be used in functions or alone in a cell following an '=' sign.
Parameters are case sensitive (pageNumber is not the same as pagenumber). Parameter names can not contain the '@' symbol.
For a list of parameters and their descriptions, see Full Description of Parameters. Your administrator has the ability to create additional parameters.
[bookmark: _Toc468348415]Data Fields
To use a Data Field as part of a function, enter its name between curly braces: {DataCategory.DataField}
[bookmark: _Toc468348416]Referencing a Cell
To reference another cell's value, enter the column name with a capital letter and the row number between square brackets (E.g. [A2]). A cell reference can be used in functions or alone in a cell following an '=' sign.
Cell references will update if rows or columns are added or deleted; however, dragging a cell will not update cell references. This may cause errors in your formulas.
[bookmark: __RefHeading__11295_1934010483][bookmark: chapter_10_using_formulas_using__2908][bookmark: chapter_10_using_formulas_using__2612][bookmark: _Toc296683286][bookmark: _Toc306613111][bookmark: _Toc468348417]Using Formulas
Formulas can either be entered in the Formula Editor or manually keyed into cells.
[bookmark: _Formula_Editor][bookmark: _Toc306613112][bookmark: _Toc468348418]Formula Editor
1. Navigate to the Report Designer.
2. Click in the cell in which you want the formula to appear.
3. Press the Formula Editor Button ([image: ]).

[image: ]

4. Create the desired formula by selecting the desired functions and pressing [image: ] Add or by dragging and dropping the function into the Summary box.

Embed functions beginning with the outermost function and moving inward. (E.g. To get =TRUNCATE(SQRT(162)), first add Truncate then the Square Root function.)
5. Press [image: ] OK.

[bookmark: _Quick_List_of][bookmark: _Toc306613114][bookmark: _Toc468348419]Full Description of Parameters

pageNumber:
	Description
	Returns the number of the current page.

	Remark
	For RTF output, pageNumber cannot be used with other formulas. 

	Example
	=@pageNumber@ will display the current page number for all output types.
='pg. ' & @pageNumber@ will display 'pg.' followed by the page number for default and PDF outputs.
NOTE. Does not work with chained reports.


reportName:
	Description
	Returns the name of the report.


reportFullName:
	Description
	Returns the file path of the report.

	Example
	For a report named Transcripts in a Folder named Student Documents, @reportFullName@ would return Student Documents/Transcripts.
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[bookmark: _Toc306613115][bookmark: _Toc468348420]Quick List of Functions
154	Exago Inc.
Aggregate:
	AggAvg
	AggCount
	AggDistinctCount
	AggMax
	AggMin
	AggSum

Financial:
DB
DDB
Fv
Intrate
Ipmt
Nper
Npv
Pmt
Ppmt
Pv
Rate
Sln
Syd

Date:
Date
DateAdd
DateDiff
DateValue
Day
Days360
GlobalDateFormat
GlobalDateTimeFormat
Hour
Minute
Month
Now
Second
Time
TimeFormat1
TimeValue
Today
Year

Arithmetic & Geometric:
Absolute
Acos
Acosh
Asin
Asinh
Atan
Atan2
Atanh
Ceiling
Cos
Cosh
Even
Exp
Fixed
Floor
Int
Ln
Log
Log10
Mod
Odd
Pi
Power
Product
Quotient
Rand
Sin
Sinh
Sqrt
Tan
Tanh
Truncate

Formatting:
Bold
Italic
Underline

String:
Concatenate
Left
Len
Lower
Mid
NewLine
Replace
Right
Trim
Upper
Value
Operators:
&
+
-
*
/

Logical:
And
False
If
Not
Or
Switch
True
Database & Data Type:
IsEven
IsLogical
IsNonText
IsNumber
IsOdd
IsText
Null
Type
Other: 
CellValue
FilterValue
Hyperlink
LoadImage
StripHTMLTag
ExcelFormula

[bookmark: __RefHeading__11297_1934010483][bookmark: _Formula_Functions][bookmark: _Toc296683287][bookmark: _Toc306613116][bookmark: _Toc468348421]Full Description of Functions
This section provides detailed information on the available functions.
Types of Functions:
· Aggregate Functions
· Logical Functions
· Date Functions
· Financial Functions
· Database and Data Type Functions
· Arithmetic and Geometric Functions
· String Functions
· Formatting Functions
· Other Functions
[bookmark: _Agregate_Functions][bookmark: _Aggregate_Functions][bookmark: _Toc306613117][bookmark: _Toc468348422]Aggregate Functions
Aggregate functions can be executed on non-numeric fields.
AggAvg: 
	Description
	Returns the average of the values in the field.

	Remark
	Only accepts Data Fields as input.

	Example
	E.g. aggAvg({OrderDetail.Quantity}) - returns the average quantity of sales orders.


AggCount: 
	Description
	Returns the number of unique entities in the Data Category.

	Remark
	The aggCount function uses the Data Category, not the Data Field. For example, the function “aggCount( {Officer.Salary} )” counts the number of Officers. You could replace “Officer.Salary” with any other field in the Officer Data Category and the function would still count the number of officers.

Only accepts Data Fields as input.

	Example
	E.g. aggCount( {Orders.ProductPrice}) - returns the number of sales orders.


AggDistinctCount: 
	Description
	Returns the number of unique values in the Data Field.

	Remark
	Unlike aggCount, aggDistinctCount returns the number of unique values of the Data Field.

Only accepts Data Fields as input.

	Example
	E.g. aggDistinctCount({OrderDetail.Quantity}) - returns the number distinct quantities in an order. 


AggMax: 
	Description
	Returns the maximum value in the field.

	Remark
	Only accepts Data Fields as input.

	Example
	E.g. aggMax({OrderDetail.Discount}) - returns the largest discount.


AggMin: 
	Description
	Returns the minimum value in the field.

	Remark
	Only accepts Data Fields as input.

	Example
	E.g. aggMin({OrderDetail.Discount}) - returns the smallest discount.


AggSum: 
	Description
	Returns the sum of the values in the field.

	Remark
	Only accepts Data Fields as input.

	Example
	E.g. aggSum({OrderDetail.Quantity}) - returns the total quantity of units ordered.


[bookmark: _Logical_Functions_1][bookmark: chapter_10_using_formulas_append_8392][bookmark: chapter_10_using_formulas_append_6803][bookmark: _Toc296683291][bookmark: _Toc306613118][bookmark: _Toc468348423]Logical Functions
Logical functions can be used to handle conditional information.
And: 
	Description
	Returns TRUE if all its arguments are TRUE; returns FALSE if any argument is FALSE.

	Remark
	The arguments must evaluate to TRUE or FALSE. 
The And function can take more than two arguments as input.

	Example
	E.g. AND(2+2=4, 4+0=4, 2+3=6) – returns FALSE.


False: 
	Description
	Returns the logical value FALSE.

	Remark
	You can also type the word FALSE directly onto the worksheet or into a formula; it is interpreted as the logical value FALSE.


If: 
	Description
	Takes three arguments as input. Returns the second argument if the first evaluates to TRUE. Otherwise returns the third argument.

	Remark
	The first input must evaluate to TRUE or FALSE.

	Example
	E.g. if({OrderDetail.Price}= 0,'FREE',{OrderDetail.Price}) - returns FREE if the price is 0, otherwise it returns the price. 


Not: 
	Description
	Reverses the value of its argument.

	Remark
	Argument should evaluate to TRUE or FALSE.

	Example
	E.g. Not(FALSE) - returns TRUE.


Or: 
	Description
	Returns TRUE if any argument is TRUE.

	Remark
	The arguments must evaluate to logical values such as TRUE or FALSE.
The 'Or' function can take more than two arguments as input.

	Example
	E.g. OR(2+2=4, 4+0=8, 2+3=6) - returns TRUE.


Switch: 
	Description
	This functions should be used instead of placing if() function inside of if() functions.
Takes any even number of inputs arguments.

	Remark
	The 1st argument will be the test value to compare to.
The 2nd argument will be returned if none of the comparisons return true.
The 3rd, 5th, 7th… arguments will be compared to the 1st argument. When the first match occurs the following argument will be returned. 
For example if argument 3 matches argument 1 then the 4th argument will be returned. 

	Example
	E.g. Switch({Categories.CategoryName},”NOT FOUND”, “Beverages”, “Drink up!”, “Condiments”, “Enhance”, “Confections”, “Sweet Tooth”) – returns a string based on the Category Name.


True: 
	Description
	Returns the logical value TRUE.

	Remark
	You can also type the word TRUE directly onto the worksheet or into a formula; it is interpreted as the logical value TRUE.




[bookmark: __RefHeading__11299_1934010483][bookmark: _Date_&_Time][bookmark: _Date_Functions][bookmark: chapter_10_using_formulas_append_7563][bookmark: chapter_10_using_formulas_append_9197][bookmark: _Toc296683288][bookmark: _Toc306613119][bookmark: _Toc468348424]Date Functions 
Date functions can be used to do calculations and formatting on Date values. 
Date: 
	Description
	Creates a date value from three numeric values.

	Remark
	This function should be used to represent a date to other functions instead of representing a date as text.

	Example
	E.g. Date(2012,7,4) – returns the date July 4th, 2012.


DateAdd: 
	Description
	Returns the sum of a date and a quantity of time.

	Remark
	DateAdd takes three input arguments. 
A string representing the interval you want to add. The interval can be. "yyyy" (year), "y" (days), "d" (days), "w" (weeks), "m" (months), "h" (hours), "n" (minutes), "s" (seconds), "ww" (weeks of year), or "q" (quarters). 
A real number representing how much time you want to add to the date. 
A DateValue.


	Example
	E.g. DateAdd('h',1,Now()) – returns the date and time 1 hour from now.


DateDiff: 
	Description
	Returns the amount of time between two dates. 

	Remark
	DateDiff takes three input arguments. 
A string representing the interval you want to add. The interval can be. "yyyy" (year), "y" (days), "d" (days), "w" (weeks), "m" (months), "h" (hours), "n" (minutes), "s" (seconds), "ww" (weeks of year), or "q" (quarters). 
The first date value.
The second date value.

	Example
	E.g. DateDiff(“yyyy”, date(1787,9,17), now())- returns the number of years since the signing of the United States' Constitution


DateValue: 
	Description
	Converts a date represented as text (e.g. '30-jan-2008') to a date value. 

	Remark
	Any time information in the Date_text is ignored. The ticks returned always represent a time-of-day of Midnight (in the server's local time).
If the year portion of Date_text is omitted, DATEVALUE uses the current year on the server.
Use this function when comparing two dates.

	Example
	E.g. DateValue(30-jun-2011) – returns the date object 6/30/2011.
E.g. DateValue({Orders.OrderDate}) > DateValue(Today()) – compares the order date to today.


Day: 
	Description
	Returns the day portion of a date as a whole number.

	Remark
	Values returned by the YEAR, MONTH and DAY functions will be Gregorian Calendar values regardless of the display format for the supplied date value.

	Example
	E.g. Day({Appointment.Date}) - returns the day of the appointment.



Day360: 
	Description
	Returns the number of days between two dates based on a 360-day year. 

	Remark
	Often used in accounting applications.
Date360 takes three input arguments. 
The first date value.
The second date value.
Optional: True/False indicating to use European or American method of computation. If not included the American method is used.

	Example
	E.g. Day360({Appointment.Date},today())- returns the number of days between today and the appointment date.



GlobalDateFormat: 
	Description
	Returns a DATE value whose format is based on the session format.

	Remark
	Only accepts data objects as input.

	Example
	E.g. GlobalDateFormat({Appointment.Date})- returns the date of the appointment based on the session format.



GlobalDateTimeFormat: 
	Description
	Returns a DATETIME value whose format is based on the session format.

	Remark
	Only accepts data objects as input.

	Example
	E.g. GlobalDateTimeFormat({Appointment.Date})- returns the date and time of the appointment based on the session format.


Hour: 
	Description
	Returns the hour of a time value ranging from 0 (12:00 AM) to 23 (11:00 PM). 

	Remark
	Times may be entered as text strings within quotation marks or a date time value.

	Example
	E.g.  Hour("2:50:05PM") – returns 14.


Minute: 
	Description
	Returns the Minute of a time value ranging from 0 to 59. 

	Remark
	Times may be entered as text strings within quotation marks or a date time value.

	Example
	E.g.  Minute("2:50:05PM") – returns 50.


Month: 
	Description
	Returns the month portion of a date as a whole number, ranging from 1 (January) to 12 (December).

	Remark
	Values returned by the YEAR, MONTH and DAY functions will be Gregorian Calendar values regardless of the display format for the supplied date value.

	Example
	E.g. Month({Appointment.Date})- returns the month of the appointment.


Now: 
	Description
	Returns today's date and time (in local server time).

	Remark
	If embedding in other functions use Now('false').

	Example
	E.g. Now() - returns the current date and time. 
Now('false') returns the current date and time formatted MM/dd/yyyy hh:mm:ss.


Second: 
	Description
	Returns the seconds of a time value ranging from 0 to 59. 

	Remark
	When a time omits seconds, 0 (zero) is assumed.
Times may be entered as text strings within quotation marks or a date time value.

	Example
	E.g.  Second("2:50:05PM") – returns 5.


Time: 
	Description
	Returns the number of ticks in a period of hours, minutes and seconds.

	Remark
	This function should be used to represent a time to other functions instead of representing a time as text.
Time takes three input arguments. 
Hours
Minutes
Seconds

	Example
	E.g.  Time(14,50,5) – returns 534050000000.


TimeFormat1:
	Description
	Returns the time component of a DATETIME input as a time object.

	Remark
	This function should be used to represent a time to other functions instead of representing a time as text.
The return value of this function should be formatted as Text. Cells formatted as General or Date may contain an erroneous placeholder date.

	Example
	E.g.  Timeformat1({Appointment.Date}) – returns the time component of the appointment date in the format 'hh:mm tt'.


TimeValue:
	Description
	Convert a time represented in text (i.e., “HH-mm-ss”) into time values that can be passed to other functions.

	Remark
	Acceptable formats include "5:55 PM" and "17:55". A time separator is mandatory ("17:00" is acceptable, "1700" is not).
If AM/PM is not present AM is assumed. When specifying AM or PM, do not use periods ("A.M." or "P.M." will return an error).
The return value of this function should be formatted as Text. Cells formatted as General or Date may contain an erroneous placeholder date.

	Example
	E.g. TimeValue(Time(14,50,5)) – returns the time object 14:50:05.


Today:
	Description
	Returns today's date with no time component.

	Remark
	If embedding in other functions use Today('false').
See the Now() function to get today's date with its time component.

	Example
	E.g. Today()- returns the current date.
Today('false') returns the current date formatted as MM/dd/yyyy.


Year:
	Description
	Returns the year portion of a date as a whole number, ranging from 1 to 9999.

	Example
	E.g.  Year(today()) – returns 2011.


[bookmark: __RefHeading__11301_1934010483][bookmark: _Financial_Functions][bookmark: chapter_10_using_formulas_append_2678][bookmark: chapter_10_using_formulas_append_5791][bookmark: _Toc296683289][bookmark: _Toc306613120][bookmark: _Toc468348425]Financial Functions
DB: 
	Description
	Returns the depreciation of an asset for a specified period using the fixed-declining balance method. Cost is the initial cost of the asset. Salvage is the value at the end of the depreciation (sometimes called the salvage value of the asset). Life is the number of periods over which the asset is being depreciated (sometimes called the useful life of the asset). Period is the period for which you want to calculate the depreciation. Period must use the same units as life. Month is the number of months in the first year. If month is omitted, it is assumed to be 12.

	Remark
	The fixed-declining balance method computes depreciation at a fixed rate. DB uses the following formulas to calculate depreciation for a period: (cost - total depreciation from prior periods) * rate where: rate = 1 - ((salvage / cost) ^ (1 / life)), rounded to three decimal places. Depreciation for the first and last periods is a special case. For the first period, DB uses this formula: cost * rate * month / 12. For the last period, DB uses this formula: ((cost - total depreciation from prior periods) * rate * (12 - month)) / 12.

	Example
	Data Assumptions: Initial cost=1,000,000 (A2); Salvage value=100,000 (A3); Lifetime in years=6 (A4). 
E.g. DB([A2],[A3],[A4],1,7) - Depreciation in first year, with only 7 months calculated (186,083.33). 
E.g. DB([A2],[A3],[A4],2,7) - Depreciation in second year (259,639.42). 
E.g. DB([A2],[A3],[A4],3,7) - Depreciation in third year (176,814.44).
E.g. DB([A2],[A3],[A4],4,7) - Depreciation in fourth year (120,410.64). 
E.g. DB([A2],[A3],[A4],5,7) - Depreciation in fifth year (81,999.64). 
E.g. DB([A2],[A3],[A4],6,7) - Depreciation in sixth year (55,841.76). 
E.g. DB([A2],[A3],[A4],7,7) - Depreciation in seventh year, with only 5 months 
calculated (15,845.10).


 DDB: 
	Description
	Returns the depreciation of an asset for a specified period using the double-declining balance method or some other method you specify. Cost is the initial cost of the asset. Salvage is the value at the end of the depreciation (sometimes called the salvage value of the asset). Life is the number of periods over which the asset is being depreciated (sometimes called the useful life of the asset). Period is the period for which you want to calculate the depreciation. Period must use the same units as life. Factor is the rate at which the balance declines. If factor is omitted, it is assumed to be 2 (the double-declining balance method). 
All five arguments must be positive numbers.

	Remark
	The double-declining balance method computes depreciation at an accelerated rate. Depreciation is highest in the first period and decreases in successive periods. DDB uses the following formula to calculate depreciation for a period: ((cost-salvage) - total depreciation from prior periods) * (factor/life). Change factor if you do not want to use the double-declining balance method. Use the VDB function if you want to switch to the straight-line depreciation method when depreciation is greater than the declining balance calculation.

	Example
	Data Assumptions: Initial cost=2400 (A2); Salvage value=300 (A3); Lifetime in years=10 (A4). 
E.g. DDB([A2],[A3],[A4]*365,1)  - First day's depreciation. 
E.g. DDB([A2],[A3],[A4]*12,1,2) - First month's depreciation (40.00). 
E.g. DDB([A2],[A3],[A4],1,2) - First year's depreciation (480.00). 
E.g. DDB([A2],[A3],[A4],10) - Tenth year's depreciation. 
The results are rounded to two decimal places.


FV: 
	Description
	Returns the future value of an investment based on periodic, constant payments and a constant interest rate.

	Remark
	For a more complete description of the arguments in FV and for more information on annuity functions, see PV (Above). Rate is the interest rate per period. Nper is the total number of payment periods in an annuity. Pmt is the payment made each period; it cannot change over the life of the annuity. Typically, pmt contains principal and interest but no other fees or taxes. If pmt is omitted, you must include the pv argument. Pv is the present value, or the lump-sum amount that a series of future payments is worth right now. If pv is omitted, it is assumed to be 0 (zero), and you must include the pmt argument. Type is the number 0 or 1 and indicates when payments are due. If type is omitted, then it is assumed to be 0. Make sure that you are consistent about the units you use for specifying rate and nper. If you make monthly payments on a four-year loan at 12 percent annual interest, use 12%/12 for rate and 4*12 for nper. If you make annual payments on the same loan, use 12% for rate and 4 for nper. For all the arguments, cash you pay out, such as deposits to savings, is represented by negative numbers; cash you receive, such as dividend checks, is represented by positive numbers.

	Example
	Data Assumptions: Annual interest rate=6% (A2); Number of payments=10 (A3); Amount of the payment=-200 (A4); Present value=-500 (A5); Payment is due at the beginning of the period=1 (A6)...(see above). 
E.g. FV([A2]/12, [A3], [A4], [A5], [A6]) – returns future value of an investment with these terms (2,581.40).


 Intrate: 
	Description
	Returns the interest rate for a fully invested security. 
Dates should be entered by using the DATE function, or as results of other formulas or functions. 
For example, use DATE(2008,5,23) for the 23rd day of May, 2008. Problems can occur if dates are entered as text. Settlement is the security's settlement date. The security settlement date is the date after the issue date when the security is traded to the buyer. Maturity is the security's maturity date. The maturity date is the date when the security expires. Investment is the amount invested in the security. Redemption is the amount to be received at maturity. Basis is the type of day count basis to use.

	Remark
	The settlement date is the date a buyer purchases a coupon, such as a bond. The maturity date is the date when a coupon expires. For example, suppose a 30-year bond is issued on January 1, 2008, and is purchased by a buyer six months later. The issue date would be January 1, 2008, the settlement date would be July 1, 2008, and the maturity date would be January 1, 2038, which is 30 years after the January 1, 2008, issue date. Settlement, maturity, and basis are truncated to integers. If settlement or maturity is not a valid date, INTRATE returns the #VALUE! error value. If investment = 0 or if redemption = 0, INTRATE returns the #NUM! error value. If basis < 0 or if basis > 4, INTRATE returns the #NUM! error value. If settlement = maturity, INTRATE returns the #NUM! error value.

	Example
	Data Assumptions...Settlement date=February 15, 2008 (A2); Maturity date=May 15, 2008 (A3); Investment=1,000,000 (A4); Redemption value=1,014,420 (A5); Actual/360 basis (see above)=2 (A6). 
E.g. INTRATE([A2],[A3],[A4],[A5],[A6])  - returns discount rate, for the terms of the bond above (0.05768 or 5.77%).


Ipmt: 
	Description
	Returns the interest payment for a given period for an investment based on periodic, constant payments and a constant interest rate. For a more complete description of the arguments in IPMT and for more information about annuity functions, see PV. Rate is the interest rate per period. Per is the period for which you want to find the interest and must be in the range 1 to nper. Nper is the total number of payment periods in an annuity. Pv is the present value, or the lump-sum amount that a series of future payments is worth right now. Fv is the future value, or a cash balance you want to attain after the last payment is made. If fv is omitted, it is assumed to be 0 (the future value of a loan, for example, is 0). Type is the number 0 or 1 and indicates when payments are due. If type is omitted, it is assumed to be 0.

	Remark
	Make sure that you are consistent about the units you use for specifying rate and nper. If you make monthly payments on a four-year loan at 12 percent annual interest, use 12%/12 for rate and 4*12 for nper. If you make annual payments on the same loan, use 12% for rate and 4 for nper. For all the arguments, cash you pay out, such as deposits to savings, is represented by negative numbers; cash you receive, such as dividend checks, is represented by positive numbers.

	Example
	Data Assumptions: Annual interest=10% (A2); Period for which you want to find the interest=1 (A3); Years of loan=3 (A5); Present value of loan=8000 (A6). 
E.g. IPMT([A2]/12, [A3]*3, [A4], [A5]) - Interest due in the first month for a loan with the terms above (-22.41). 

The interest rate is divided by 12 to get a monthly rate. The years the money is paid out is multiplied by 12 to get the number of payments.


Nper: 
	Description
	Returns the number of periods for an investment based on periodic, constant payments and a constant interest rate. For a more complete description of the arguments in NPER and for more information about annuity functions, see PV (above). Rate is the interest rate per period. Pmt is the payment made each period; it cannot change over the life of the annuity. Typically, pmt contains principal and interest but no other fees or taxes. Pv is the present value, or the lump-sum amount that a series of future payments is worth right now. Fv is the future value, or a cash balance you want to attain after the last payment is made. If fv is omitted, it is assumed to be 0 (the future value of a loan, for example, is 0). Type is the number 0 or 1 and indicates when payments are due.

	Remark
	Set Type equal to 0 (or omitted) if payments are due at the end of the period; Set type equal to 1 if payments are due at the beginning of the period.

	Example
	Data Assumptions: Annual interest rate=12% (A2); Payment made each period=-100 (A3); Present Value=-1000 (A4); Future Value=10000 (A5); Payment is due at the beginning of the period=1 (A6). 
E.g. NPER([A2]/12, [A3], [A4], [A5], 1) - Periods for the investment with the above terms (60). 
E.g. NPER([A2]/12, [A3], [A4], [A5]) - Periods for the investment with the above terms, except payments are made at the beginning of the period (60). 
E.g. NPER([A2]/12, [A3], [A4]) - Periods for the investment with the above terms, except with a future value of 0 (-9.578).


Npv: 
	Description
	Calculates the net present value of an investment by using a discount rate and a series of future payments (negative values) and income (positive values). Rate is the rate of discount over the length of one period. Value1, value2, ...are 1 to 29 arguments representing the payments and income. Value1, value2, ...must be equally spaced in time and occur at the end of each period. NPV uses the order of value1, value2, ...to interpret the order of cash flows. Be sure to enter your payment and income values in the correct sequence. Arguments that are numbers, empty cells, logical values, or text representations of numbers are counted; arguments that are error values or text that cannot be translated into numbers are ignored. If an argument is an array or reference, then only numbers in that array or reference are counted. Empty cells, logical values, text, or error values in the array or reference are ignored.

	Remark
	The NPV investment begins one period before the date of the value1 cash flow and ends with the last cash flow in the list. The NPV calculation is based on future cash flows. If your first cash flow occurs at the beginning of the first period, the first value must be added to the NPV result, not included in the values arguments. For more information, see the example below. NPV is similar to the PV function (present value). The primary difference between PV and NPV is that PV allows cash flows to begin either at the end or at the beginning of the period. Unlike the variable NPV cash flow values, PV cash flows must be constant throughout the investment. For information about annuities and financial functions, see PV. NPV is also related to the IRR function (internal rate of return). IRR is the rate for which NPV equals zero: NPV(IRR(...), ...) = 0.

	Example
	Data Assumptions: Annual discount rate=10% (A2); Initial cost of investment one year from today=-10,000 (A3); Return from first year=3,000 (A5); Return from second year=4,200 (A6).
E.g. NPV([A2], [A3], [A4], [A5], [A6]) - Net present value of this investment (1,188.44) ...In the preceding example, you include the initial $10,000 cost as one of the values, because the payment occurs at the end of the first period.


Pmt: 
	Description
	Calculates the payment for a loan based on constant payments and a constant interest rate. For a more complete description of the arguments in PMT, see the PV function. Rate is the interest rate for the loan. Nper is the total number of payments for the loan. Pv is the present value, or the total amount that a series of future payments is worth now; also known as the principal. Fv is the future value, or a cash balance you want to attain after the last payment is made. If fv is omitted, it is assumed to be 0 (zero), that is, the future value of a loan is 0. Type is the number 0 (zero) or 1 and indicates when payments are due.

	Remark
	The payment returned by PMT includes principal and interest but no taxes, reserve payments, or fees sometimes associated with loans. Make sure that you are consistent about the units you use for specifying rate and nper. If you make monthly payments on a four-year loan at an annual interest rate of 12 percent, use 12%/12 for rate and 4*12 for nper. If you make annual payments on the same loan, use 12 percent for rate and 4 for nper.

	Example
	Data Assumptions: Annual interest rate=8% (A2); Number of months of payments=10 (A3); Amount of loan=10000 (A4).
E.g. PMT([A2]/12, [A3], [A4]) - Monthly payment for a loan with the above terms (-1,037.03).
E.g. PMT([A2]/12, [A3], [A4], 0, 1) - Monthly payment for a loan with the above terms, except payments are due at the beginning of the period (-1,030.16).


Ppmt: 
	Description
	Returns the payment on the principal for a given period for an investment based on periodic, constant payments and a constant interest rate. For a more complete description of the arguments in PPMT, see PV (above). Rate is the interest rate per period. Per specifies the period and must be in the range 1 to nper. Nper is the total number of payment periods in an annuity. Pv is the present value—the total amount that a series of future payments is worth now. Fv is the future value, or a cash balance you want to attain after the last payment is made. If fv is omitted, it is assumed to be 0 (zero), that is, the future value of a loan is 0. Type is the number 0 or 1 and indicates when payments are due.

	Remark
	Make sure that you are consistent about the units you use for specifying rate and nper. If you make monthly payments on a four-year loan at 12 percent annual interest, use 12%/12 for rate and 4*12 for nper. If you make annual payments on the same loan, use 12% for rate and 4 for nper.

	Example
	Data Assumptions: Annual interest rate=10% (A2); Number of years in the loan=2 (A3); Amount of loan=2000 (A4).
E.g. PPMT([A2]/12, 1, [A3]*12, [A4]) - Payment on principle for the first month of loan (-75.62). 

The interest rate is divided by 12 to get a monthly rate. The number of years the money is paid out is multiplied by 12 to get the number of payments.


Pv: 
	Description
	Returns the present value of an investment. The present value is the total amount that a series of future payments is worth now. For example, when you borrow money, the loan amount is the present value to the lender. Rate is the interest rate per period. For example, if you obtain a car loan at a 10% annual interest rate and make monthly payments, your interest rate per month is 10%/12, or 0.83%. You would enter 10%/12, or 0.83%, or 0.0083, into the formula as the rate. Nper is the total number of payment periods in an annuity. For example, if you get a four-year car loan and make monthly payments, your loan has 4*12 (or 48) periods. You would enter 48 into the formula for nper. Pmt is the payment made each period and cannot change over the life of the annuity. Typically, pmt includes principal and interest, but no other fees or taxes. For example, the monthly payments on a $10,000, four-year car loan at 12 percent are $263.33. You would enter -263.33 into the formula as the pmt. If pmt is omitted, you must include the fv argument. Fv is the future value, or a cash balance you want to attain after the last payment is made. If fv is omitted, then it is assumed to be 0 (the future value of a loan, for example, is 0). For example, if you want to save $50,000 to pay for a special project in 18 years, then $50,000 is the future value. You could then make a conservative guess at an interest rate and determine how much you must save each month. If fv is omitted, then you must include the pmt argument. Type is the number 0 or 1 and indicates when payments are due.

	Remark
	Make sure that you are consistent about the units you use for specifying rate and nper. If you make monthly payments on a four-year loan at 12 percent annual interest, use 12%/12 for rate and 4*12 for nper. If you make annual payments on the same loan, use 12% for rate and 4 for nper. In annuity functions, cash you pay out, such as a deposit to savings, is represented by a negative number; cash you receive, such as a dividend check, is represented by a positive number. For example, a $1,000 deposit to the bank would be represented by the argument -1000 if you are the depositor and by the argument 1000 if you are the bank.

	Example
	Data Assumptions: Money paid out of an insurance annuity at the end of every month=500 (A2); 8% is the interest rate earned on the money paid out (A3); 20 is the number of years the money will be paid out (A4).
E.g. Pv([A3]/12, 12*[A4], [A2], , 0) - Present value of an annuity with the stated terms (-59,777.15). The result is negative because it represents money that you would pay in an outgoing cash flow. If you are asked to pay ($60,000) for the annuity, you would determine this would not be a good investment because the present value of the annuity (59,777.15) is less than what you are asked to pay. 
The interest rate is divided by 12 to get a monthly rate. The years the money is paid out is multiplied by 12 to get the number of payments.


Rate: 
	Description
	Returns the interest rate per period of an annuity. RATE is calculated by iteration and can have zero or more solutions. If the successive results of RATE do not converge to within 0.0000001 after 20 iterations, RATE returns the #NUM! error value. For a complete description of the arguments nper, pmt, pv, fv, and type, see PV. Nper is the total number of payment periods in an annuity. Pmt is the payment made each period and cannot change over the life of the annuity. Typically, pmt includes principal and interest but no other fees or taxes. If pmt is omitted, you must include the fv argument. Pv is the present value—the total amount that a series of future payments is worth now. Fv is the future value, or a cash balance you want to attain after the last payment is made. If fv is omitted, it is assumed to be 0 (the future value of a loan, for example, is 0). Type is the number 0 or 1 and indicates when payments are due.

	Remark
	Guess is your guess for what the rate will be. If you omit guess, it is assumed to be 10 percent. If RATE does not converge, try different values for guess. RATE usually converges if guess is between 0 and 1. Make sure that you are consistent about the units you use for specifying guess and nper. If you make monthly payments on a four-year loan at 12 percent annual interest, use 12%/12 for guess and 4*12 for nper. If you make annual payments on the same loan, use 12% for guess and 4 for nper.

	Example
	Data Assumptions: Years of the loan=4 (A2); Monthly payment=-200 (A3); Amount of the loan=8000 (A4).
E.g. Rate([A2]*12, [A3], [A4]) - Monthly rate of the loan with the stated terms (1%).
The number of years of the loan is multiplied by 12 to get the number of months.


Sln: 
	Description
	Returns the straight-line depreciation of an asset for one period.

	Remark
	Cost is the initial cost of the asset. Salvage is the value at the end of the depreciation (sometimes called the salvage value of the asset). Life is the number of periods over which the asset is depreciated (sometimes called the useful life of the asset).

	Example
	Data Assumptions: Cost=30,000 (A2); Salvage value=7,500 (A3); Years of useful life=10 (A4).
E.g. Sln([A2], [A3], [A4]) - The depreciation allowance for each year (2,250).


Syd: 
	Description
	Returns the sum-of-years' digits depreciation of an asset for a specified period.

	Remark
	Cost is the initial cost of the asset. Salvage is the value at the end of the depreciation (sometimes called the salvage value of the asset). Life is the number of periods over which the asset is depreciated (sometimes called the useful life of the asset). Per is the period and must use the same units as life.

	Example
	Data Assumptions: initial cost=30,000 (A2); Salvage value=7,500 (A3); Lifespan in years=10 (A4).
E.g. Syd([A2], [A3], [A4], 1) - Yearly depreciation allowance for the first year (4,090.91).
E.g. Syd([A2], [A3], [A4], 10) - Yearly depreciation allowance for the tenth year (409.09).
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DataRowCount: 	
	Description
	Returns the number of rows retrieved from the data source when executing the report.

	Example
	Suppose report is run to retrieve basic information on 10 employees
E.g. DataRowCount() should return 10.


IsEven: 
	Description
	Checks if a value is an even number.

	Example
	E.g. IsEven([A1]) – returns TRUE if the cell [A1] contains an even number, FALSE otherwise.


IsLogical: 
	Description
	Checks if a value is TRUE or FALSE.

	Example
	E.g. IsLogical([A1]) – returns TRUE if the cell [A1] contains TRUE/FALSE, FALSE otherwise.


IsNonText: 
	Description
	Checks if a value is not text.

	Remark
	Non Text values include dates, numbers, images and blank cells.

	Example
	E.g. IsNonText([A1]) – returns TRUE if the cell [A1] contains non text, FALSE otherwise.


IsNoDataQualified: 	
	Description
	Returns True if no data qualified for the report execution. Otherwise it returns false.

	Example
	Suppose report is run to retrieve basic information on 10 employees
E.g. IsNoDataQualified() returns false.


IsNumber: 
	Description
	Checks if a value is a number.

	Remark
	Does not convert text to numbers. Ex IsNumber(“19”) returns FALSE.

	Example
	E.g. IsNumber([A1]) – returns TRUE if the cell [A1] contains a number, FALSE otherwise.


IsOdd: 
	Description
	Checks if a value is odd.

	Example
	E.g. IsOdd([A1]) – returns TRUE if the cell [A1] contains an odd number, FALSE otherwise.


IsText: 
	Description
	Checks if a value is text.

	Example
	E.g. IsText([A1]) – returns TRUE if the cell [A1] contains text, FALSE otherwise.


Null: 
	Description
	Returns a null value (Nothing in VB).


Type: 
	Description
	Returns the type of value.

	Remark
	Returns 1 if the value is a number, 2 if it is text.

	Example
	E.g. Type(“John Smit”) – returns 2.
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Abs: 
	Description
	Returns the absolute value of a number.

	Example
	E.g. Abs(-23.1) – returns 23.1.


Acos: 
	Description
	Returns the arccosine, or inverse cosine, of a number. 

	Remark
	The input must be from -1 to 1.

The returned angle is given in radians in the range 0 (zero) to pi. If you want to convert the result from radians to degrees, then multiply it by 180/PI() or use the DEGREES function.

	Example
	E.g. Acos(-.231) – returns 1.80390168255052.


Acosh: 
	Description
	Returns the inverse hyperbolic cosine of the given number.

	Remark
	The input must be a real number greater than or equal to 1.

	Example
	E.g. Acosh(10) – returns 2.993223.


Asin: 
	Description
	Returns the arcsine of the given number in radians, in the range -Pi/2 to Pi/2.

	Remark
	The input is the sine of the angle you want and must be in the range from -1 to 1.

	Example
	E.g. Asin(-0.5) – returns 0.5236.


Asinh: 
	Description
	Returns the inverse hyperbolic sine of a number. 

	Remark
	The input can be any real number.
asinh(sinh(n)) returns n. 

	Example
	E.g. Asinh(-2.5) – returns -1.64723.


Atan: 
	Description
	Returns the arctangent, inverse tangent of a number. 

	Remark
	The input can be any real number.
Atan returns an angle given in radians in the range -Pi/2 to Pi/2.

	Example
	E.g. Atan(1) – returns 0.785398 (pi/4).


Atan2: 
	Description
	Returns the angle from the x-axis to a line containing the origin (0, 0) and a point with coordinates (x,y).

	Remark
	The input requires two values, the x and y coordinates. 
If both x,y are 0, then Atan2 will return the error #Div/0!
A negative result represents a clockwise angle. 

	Example
	E.g. Atan2(1, 1) – returns 0.785398 (pi/4).


Atanh: 
	Description
	Returns the inverse hyperbolic tangent of a number.

	Remark
	The input must be from -1 to 1.

Atanh(tanh(n)) returns n.

	Example
	E.g. Atanh(.76159416) – returns 1 (approximately).


Ceiling: 
	Description
	Returns the number rounded up, away from zero, to the nearest multiple of significance.

	Remark
	The input requires two values, the number to be rounded and the multiple of significance.
Regardless of the sign of number, a value is rounded up when adjusted away from zero.
If the argument is non-numeric, then Ceiling returns the error #VALUE!

	Example
	E.g. Ceiling(4.42,.05) – returns 4.45.


Cos: 
	Description
	Returns the cosine, of an angle in radians.

	Remark
	The returned angle is given in radians in the range 0 (zero) to pi. If you want to convert the result from radians to degrees, then multiply it by 180/PI() or use the DEGREES function.

	Example
	E.g. Cos(1.047) – returns 0.500171.


Cosh: 
	Description
	Returns the hyperbolic cosine of a number.

	Example
	E.g. Cos(4) – returns 27.30823. 


Even: 
	Description
	Returns a number rounded up to the nearest even integer.

	Remark
	Regardless of the sign of number, a value is rounded away from zero.
If the number is non-numeric, then EVEN returns the error #VALUE!

	Example
	E.g. Even(1.5) – returns 2. 


Exp: 
	Description
	Returns e raised to the power of the input.

	Remark
	Exp is the inverse of Ln, the natural logarithm.

	Example
	E.g. Exp(1) – returns 2.718282 (the approximate value of e).


Fixed: 
	Description
	Returns the first argument rounded to the number of decimal places specified in the second argument.

	Remark
	Takes three input values:
1. The number you want to round.
2. The number of digits to the right of the decimal to include.
3. (Optional) TRUE/FALSE whether to omit commas. The default is FALSE (includes commas as normal).

	Example
	E.g. Fixed(1234.5678, 2) – returns 1,234.56.


Floor: 
	Description
	Rounds the number down, toward zero, to the nearest multiple of significance.

	Remark
	The input requires two values, the number to be rounded, and the multiple of significance.
Regardless of the sign of number, a value is down toward zero.
If the argument is non-numeric, then Floor returns the error #VALUE!

	Example
	E.g. Floor(2.6, .5) – returns 2.5.


Int: 
	Description
	Rounds a number down to the nearest integer.

	Remark
	The input must be a real number. 

	Example
	E.g. Int(2.6) – returns 2.


Ln: 
	Description
	Returns the natural logarithm of a number.

	Remark
	LN is the inverse of the EXP function.

	Example
	E.g. Ln(86) – returns 4.454347.


Log: 
	Description
	Returns the logarithm of a number to the base you specify.

	Remark
	The first input is the number and the second is the base (if omitted base 10 used). 

	Example
	E.g. Log(100) – returns 2.


Log10: 
	Description
	Returns the base 10 logarithm of a number.

	Example
	E.g. Log10(86) – returns 1.934498451.


Mod: 
	Description
	Returns the remainder after first argument is divided by the second argument.

	Remark
	The second argument must not be 0. 

	Example
	E.g. Mod(27,5) – returns 2.


Odd: 
	Description
	Returns a number rounded up to the nearest odd integer.

	Remark
	The input must be a real number. Odd always rounds away from zero. 

	Example
	E.g. Mod(1.5) – returns 3.


Pi: 
	Description
	Returns the number 3.14159265358979, the mathematical constant pi, accurate to 15 digits.

	Example
	E.g. Pi() – returns 3.14159265358979.


Power: 
	Description
	Returns the result of the first argument raised to the second argument.

	Remark
	The operator ^ may be used instead of this function.

	Example
	E.g. Power(5,2) – returns 25.


Product: 
	Description
	Returns the product of the arguments.

	Remark
	The * symbol may be used in place of product.
Arguments must be numbers, cell references or text representations of numbers. 

	Example
	E.g. Product(5,2) – returns 10. Also 5 * 2 - returns 10.


Quotient: 
	Description
	Returns the integer portion of a division.

	Remark
	The / symbol may be used in place of product.
This function discards the remainder of the division.

	Example
	E.g. Quotient(5,2) – returns 2. Also 5/2 – returns 2.


Rand: 
	Description
	Returns an evenly-distributed random number between 0 and 1 (inclusive).

	Remark
	To generate a random real number between a and b, use: RAND()*(b-a)+a.

	Example
	E.g. Rand() – returns a random number between 0 and 1.


Round: 
	Description
	Returns a rounded number.

	Remark
	Takes one or two input:
The number to round.
2.  The number of decimal places desired.

	Example
	E.g. Round(5.236, 2) – returns 5.24


RunningSum: 
	Description
	Returns a running total of the input field.

	Remark
	Takes one or two input:
The Data Field you want to sum.
2. OPTIONAL: A Data Field or Category. The running sum will reset to 0 whenever there is a new value for this Data Field or Category.
RunningSum should not be used with the AutoSum feature.

	Example
	E.g. 
1. RunningSum({Employees.Salary}) – returns running total of all the employee's salary.
2. RunningSum({Employees.Salary}, {Employees.Region}) – returns a running total of employee's salary for each region.
3. RunningSum({Employees.Salary}, {Company}) – returns a running total of employee's salary for each Company.


Sin: 
	Description
	Returns the sine of the given angle.

	Remark
	The returned angle is given in radians in the range 0 (zero) to pi. If you want to convert the result from radians to degrees, then multiply it by 180/PI() or use the DEGREES function.

	Example
	E.g. Sin(1.047) – returns .0865926611287823.


Sinh: 
	Description
	Returns the hyperbolic sine of a number.

	Example
	E.g. Sinh(4) – returns 27.1899171971278.


Sqrt: 
	Description
	Returns the positive square root of the argument.

	Remark
	If the input is negative Sqrt returns the error #NUM!.

	Example
	E.g. Sqrt(25) – returns 5.


Tan: 
	Description
	Returns the tangent of the given angle.

	Remark
	The returned angle is given in radians in the range 0 (zero) to pi. If you want to convert the result from radians to degrees, then multiply it by 180/PI() or use the DEGREES function.

	Example
	E.g. Tan(.785) – returns .99920.


Tanh: 
	Description
	Returns the hyperbolic tangent of a number.

	Example
	E.g. Tanh(-2) – returns .96403.


Truncate: 
	Description
	Truncates a number to an integer by removing the fractional part of the number.

	Remark
	INT and TRUNC are different only when using negative numbers: TRUNC (-4.3) returns -4, but INT (-4.3) returns -5 because -5 is the lower number.

	Example
	E.g. Truncate(9.9) – returns 9.


[bookmark: __RefHeading__11309_1934010483][bookmark: _Statistical_Functions]
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Concatenate: 
	Description
	Joins several text strings into one text string.

	Remark
	The "&" operator can be used instead of CONCATENATE to join text items.

	Example
	E.g. Concatenate(“This “, “is “, “one string!” ) – returns This is one string!


Left: 
	Description
	Returns the first character(s) of a text string.

	Remark
	The first argument is the string you want to display. The second argument is number of characters you want.

	Example
	E.g. Left(“example”, 2 ) – returns E.g.


Len: 
	Description
	Returns the number of characters in a text string.

	Example
	E.g. Len(“example” ) – returns 7.


Lower: 
	Description
	Converts all uppercase letters in a text string to lowercase.

	Example
	E.g. Lower(“EXAMPLE” ) – returns example.


Mid: 
	Description
	Returns a specific number of characters from a text string starting where you specify. 

	Remark
	Mid takes three input arguments:
1. The text string.
2. The place you want to start.
3. The number of characters you want to display.

	Example
	E.g. Mid(“example” , 2, 3) – returns xam.


NewLine: 
	Description
	Begins a new line of text.


Replace: 
	Description
	Replaces part of a text string.  

	Remark
	Replace takes four input arguments:
1. The text string to partially replaced.
2. The place you want to start replacing.
3. The number of characters to replace.
3. The string you want to substitute. 

	Example
	E.g. Replace("example", 2, 3, "*") – returns e*ple.


Right: 
	Description
	Returns the last characters in a text string.

	Remark
	The first argument is the string you want to display. The second argument is number of characters you want.

	Example
	E.g. Right("example", 2) – returns le.


Trim: 
	Description
	Removes all spaces from text except for single spaces between words.

	Example
	E.g. Trim("This     sentence     has   weird    spacing.", 2) – returns This sentence has weird spacing.


Upper: 
	Description
	Converts text to uppercase.

	Example
	E.g. Upper("example") – returns EXAMPLE.


Value: 
	Description
	Converts a text string that represents a number to a number.

	Example
	E.g. Value("$1,000") – returns 1000.



[bookmark: _Other_Functions][bookmark: _Formatting_Functions][bookmark: _Toc468348429][bookmark: _Toc306613124]Formatting Functions
Bold: 
	Description
	Applies the bold formatting to the input.

	Remark
	Can be used to bold part but not all of the text in a cell.
An entire cell can be made bold using the bold button in the toolbar or ctrl + B.

	Example
	E.g. ='The second half of '& bold('this sentence is bold.') – returns 'The second half of this sentence is bold.' 


Italic: 
	Description
	Applies the italic formatting to the input.

	Remark
	Can be used to italic part but not all of the text in a cell.
An entire cell can be italicized using the italic button in the toolbar or ctrl + I.

	Example
	E.g. = 'The second half of '&italic ('this sentence is italic.') – returns 'The second half of this sentence is bold.' 


Underline: 
	Description
	Applies the underline formatting to the input.

	Remark
	Can be used to underline part but not all of the text in a cell.
An entire cell can be underlined using the underline button in the toolbar or ctrl + U.

	Example
	E.g. = 'The second half of '&underline ('this sentence is underlined.') – returns 'The second half of this sentence is underlined.' 


[bookmark: _Other_Functions_1][bookmark: _Toc468348430]Other Functions
CellValue: 	
	Description
	Returns the value of the current cell.

	Remark
	This function is only used in Conditional Formatting.

	Example
	Suppose a cell of a report displays the price of products. 
E.g. CellValue()>150 returns True if the price of the product is greater than 150.


FilterValue: 	
	Description
	Returns the current value of a filter.

	Remark
	Takes three arguments.
1. The index of the filter.
2. The sub-index used for filters that contain multiple values (i.e. between or one of).
3. (Optional) a true/false indicator if the value should be formatted following the user's culture settings. This is used for numbers and dates.   
If there are no filters the function will return an Index out of Range message.
Indexes begin with 1.

	Example
	Suppose the filter summary is “Order Detail.UnitPrice > '3.6' and Products.ProductName is one of ('Boston Crab Meat', 'Tofu')”.
E.g. FilterValue(2,2) returns Tofu.


Hyperlink: 	
	Description
	Creates a hyperlink to an external website.

	Remark
	Takes two arguments.
1. The URL of the website.
2. (Optional) the text to display in the cell.
If display text is omitted, the URL will display.
If PDF exports open in a tab within this application, then clicking the hyperlink may direct a user to leave the application.

	Example
	E.g. Hyperlink('www.fakeWebSite.com', 'click here') returns a hyperlink that displays the text 'click here' . Clicking this text will open http://www.fakeWebSite.com.


LoadImage: 	
	Description
	Loads a server side image based on the input path into the cell.

	Remark
	Can be used to load an image dynamically in place of the insert image feature. The path to the image must be in quotation marks. The entire path of the image is not required if your administrator has set a 'LoadImage' Prefix. Can also be used to load images stored in a database by using a data field as the function's argument (without quotes).

	Example
	E.g. LoadImage("C:/StarryNight.jpg")
E.g. LoadImage({Categories.Picture})


StripHtmlTags: 	
	Description
	Removes any HTML tags from the input string.

	Remark
	The input must be a string in between quotation marks.

	Example
	E.g. StripHtmlTags("<h1>This is heading 1</h1>") returns This is heading 1.


ExcelFormula: 	
	Description
	Passes an Excel formula to an Excel report..

	Remark
	The input must be a string in between quotation marks.

	Example
	E.g. ExcelFormula("SUM(A1:A100)") will pass the formula SUM(A1:A100) to Excel, which will evaluate the formula when the spreadsheet is opened.
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[bookmark: _Toc468348431]User Preferences
If given permission by your administrator, the User Preferences button will appear in the top right corner. Press the User Preferences button ([image: ]) to open the User Preferences menu.
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[bookmark: _Toc468348432]Startup Reports
In the User Preferences menu, set your preferences such as which reports should run at startup and/or what User Reports should be applied.
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· To filter a report, either drag-and-drop it to the selection pane, or select the report and press [image: ] Add, or double-click the report.
· To disable a user report, press [image: ].
[bookmark: _Toc468348433]Context Sensitive Help
Context sensitive help is available at any point in the application. Press the help button ([image: ]), and documentation will appear in a new tab. The guide will automatically open to the section that reflects the feature you are using.
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